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Getting Started with Foglight

The Quest Foglight User Guide helps you monitor your enterprise from a variety of perspectives using the Alarms, 
Domains, My Services, and Hosts dashboards. It presents workflows for drilling down and investigating problems 
in your monitored environment using these dashboards.

This guide also introduces you to navigating the Foglight browser interface and using reports to share data from 
Foglight with others in your organization.

This guide is intended for users who have been assigned the Operator or Advanced Operator role and who need 
to perform tasks such as monitoring their environment, working with alarms, and creating reports.

Getting Started
This chapter provides instructions for logging in to Foglight and describes the Welcome page you see when you 

log in with the Operator or Advanced Operator role. It also introduces you to navigating the Foglight browser 
interface and discusses best practices for navigation.

Perform these steps before following the instructions in this chapter:

• Obtain your Foglight user name and password from your Administrator.

• Ensure that your Web browser has JavaScript functionality enabled.

• Ensure that your account has the Console User role. This is required to view the new Foglight interface
components.

Logging in to Foglight 
This topic describes how to log in to the Foglight browser interface.

To log in to Foglight:
1 Open a Web browser instance.

2 Navigate to a URL that uses the following syntax:

http://localhost:8080/

NOTE: This guide uses terminology that is specific to the Foglight browser interface. For more 
information about these terms, see the Foglight User Help (navigate to Help > Help Contents > Using 
Foglight > User Help > Getting Started with Foglight > Working with Dashboards in the action panel and 
then click Working with Dashboards).

NOTE: Your Administrator may have configured Foglight so that the actual displays are different from 
those described in this chapter. The following information is intended as a general guide.

NOTE: For a list of browsers supported by Foglight, see the System Requirements and 
Platform Support Guide.
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where localhost is the name of the machine that has a running instance of the Management Server.

The Foglight login page appears.

3 Enter your user name and password in the login page.

This guide assumes that you are a user with the Operator or Advanced Operator role, in which case the 
Welcome to Foglight page is the first dashboard you see when you log in to Foglight.

Starting from the Welcome Page
Foglight Users:
An Operator’s welcome page lists the following commonly-performed tasks:

• View Your Enterprise Health: Choose one of Foglight's pre-defined views to summarize the overall health
of your IT infrastructure.

▪ View, Acknowledge, and Clear Recent Alarms: View the state of all alarms across the entire
Foglight installation in the Alarms dashboard so you can take immediate action on them. The
Alarms dashboard shows alarm counts by time, allowing you to identify excessive alarm counts or
outage events. This link takes you to the Alarms dashboard. Another way to access this dashboard
is by choosing Alarms under Homes on the navigation panel. See Viewing, Acknowledging, and
Clearing Alarms on page 49.

▪ View Enterprise Health Organized by Monitoring Domain: View an end-to-end, top-level
summary of all domains in the Domains dashboard and drill down to view their managed instances.
This link takes you to the Domains dashboard. Another way to access this dashboard is by
choosing Domains under Dashboards on the navigation panel. See Monitoring Your Domains on
page 64.

▪ View the Health of Critical Services: Choose a level of service as a focal point by subscribing to
services of interest and viewing their dependencies. This link takes you to the My Services. Another
way to access this dashboard is by choosing My Services under Dashboards on the navigation
panel. For more information, see Monitoring Your Services on page 67.

▪ View the Health of the Monitored Hosts in Your Enterprise: View alarms and a high-level
summary of performance on your monitored hosts. This link takes you to the Hosts dashboard. For
more information, see Monitoring Your Hosts on page 71.

• Configure Alarm Reporting and Blackouts: Configure the mail server and assign email routing for
Foglight alarm notifications. Configure blackout period to suspend monitoring activities.

▪ Configure Email Settings: Configure the mail server and assign email routing for Foglight alarm
notifications.

▪ Blackout Configuration: Configure blackout period to suspend monitoring activities.

• Report on Your Enterprise: View reports that are scheduled, run a report using a report template, create
a custom report, schedule a report to run at a specific time, and manage reports. This link takes you to the
Reports dashboard. Another way to access this dashboard is by choosing Reports under Homes on the
navigation panel. For more information on reports, see Reporting on Your Enterprise on page 75.

NOTE: The appearance of the Welcome page and the range of dashboards you can access from 
this page vary depending on your user role. If you have Administrator-level permissions, you can 
access advanced dashboards and configuration workflows. See the Administration and 
Configuration Guide. Users with the Operator role (but not the Administrator role) have permission to 
access a smaller set of dashboards.

If you are a user who has a role or a role combination assigned to you that does not provide 
sufficient privileges to do anything useful in Foglight, a warning page is displayed. Contact your 
Foglight Security Administrator to get additional roles assigned to your account or to request that a 
different home page be configured for you.
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▪ Build a Custom Report: Build a report template from components or specify parameters to
produce reports.

▪ Run a Report: Generate a one-time report based on a template and schedule a report to run at a
specific time.

▪ Manage Reports: Manage the schedule reports and generated reports.

• Do More with Foglight: Create custom services, build new dashboards and access other administrative
functions in Foglight.

▪ Administer Foglight: Manage users, define data retention policies, install or remove functionality,
and manage licensing.

▪ Build a Dashboard: Use the Foglight dashboard editor to create your own view onto your
enterprise infrastructure.

▪ Define Services: Create and edit services to organize your monitoring data along business lines.
Create custom SLA policies which track the health of your infrastructure from a service perspective.

▪ View Agent Status: View the status of the agents which are monitoring your enterprise, configure
existing agents, or create new agents to monitor more of your infrastructure.

▪ Contact Supportlink: Get help and technical support through Quest Software's official support
website.

▪ Explore Foglight Documentation: View the on-line help and detailed documentation to learn more
about Foglight.

• Tap into the Foglight Community: Takes you to the foglight.org Web site, which discusses topics related
to Application Management and Foglight.

The Welcome to Foglight page is your default home page. For instructions on changing your home page to a 
dashboard of your choice, see Choosing a Home Page.

Foglight Evolve Users:
When you log in to Foglight Evolve for the first time, the Getting Started tab of the Environment Overview page 
appears in the display area.

This tab displays tiles based on the products that are installed. 

From this tab, you can quickly perform a number of activities:

• Explore Hyper-V—access the Hyper-V Environment Overview page.

• Explore VMware—access the VMware Environment Overview page.

• Add Monitoring—add Hyper-V or VMware agents to your environment.

You can also obtain information about the status of your license for Foglight. This status is indicated by messages 
displayed on the tile of the installed products. For more information on licenses, see the Administration and 
Configuration Guide.

In addition, the Getting Started provides several video tutorials and the Evaluation Guide which is intended for 
anyone who wants to perform a quick evaluation of the power and ease-of-use of Foglight.

To access the Perspective views for any of the installed vFoglight cartridges, open the navigation panel, expand 
the Dashboard module, and click Perspective Selector > Perspective.

The Perspective dashboard provides a summary view of the different parts of your environment. Each perspective 
summarizes the key information related to a particular area of interest. Each perspective contains a section on the 
right side that shows the total number of alarms for each severity. Most perspectives also include a detailed view 
that list the number of objects (VMs, Hosts, and so on) within that environment, broken down by the entity’s alarm 
status. If a single object has multiple alarms, each alarm is counted. For this reason, the total number of alarms 
frequently exceeds the total number of objects with alarms.

NOTE: The General Access role is required to see the Foglight Welcome page. 
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Each perspective contains an Explore button. Click Explore to investigate the full details displayed in the VMware 
Environment dashboard.

Changes to the Foglight User Interface
Foglight 7.1.0 introduces an updated user interface that improves navigation and search functions. Some legacy 
functions are not available in the new interface components. To access these functions, you must switch to the 
previous Foglight interface (refereed to as the Classic Foglight web console). When these functions are described 
in the sections below, a note will indicate that this step is necessary. 

Refer to Opening the Foglight classic Web Console for more information.

Navigating Foglight 
In addition to the links on the Welcome page, use the navigational aids described in the sections below to navigate 
Foglight.

Using the Navigation Panel
Use the left-hand navigation panel to move between dashboards. This panel lists all dashboards that are available 
to you based on your roles. Expand a module and select a dashboard to view it in the display area (for example, 
Dashboards > Services > Service Levels). The navigation panel can be edited to show only the modules that 
interest you. You may search the navigation panel to show only dashboards matching the entered string. 

Foglight remembers the state of the navigation panel between logins, so if you make changes to the navigation 
panel when you log out, those changes will persist the next time you log in.

Changing to the Classic Foglight web console

Using the Breadcrumb Trail
The name of the current dashboard is displayed in bold at the top of the dashboard, at the end of a path called the 
breadcrumb trail.

Figure 1. An example of the breadcrumb trail.

When you move directly from one dashboard to another, the names of the previous dashboards are displayed in a 
breadcrumb trail.

Use the links in the breadcrumb trail to return to previously-viewed dashboards in a workflow or series of 
drilldowns.

NOTE: Foglight displays dynamic data that is updated regularly. For this reason, avoid using your 
browser’s navigation buttons, as this may display cached views or result in an error message. Use the 
links in the navigation panel and display area instead.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See Introduction to the Foglight User 
Interface.

http://eDocs.quest.com
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Using Drilldowns
Use the graphical and text links in views to drill down to additional details that help you diagnose problems. 
Depending on the link, you drill down to a different dashboard or a smaller view called a popup that appears above 
the dashboard you are currently viewing.

You can drill down from many different parts of a view, including names of monitored components (such as hosts 
or services), the Explore links in a popup, and items like charts, tables, cylinders, and icons.

For example, in the My Services dashboard, click the  icon will drill down further into the detailed 
information of that service.

Using Bookmarks

Use bookmarks to keep track of dashboards and views that you want to revisit or access quickly, without having to 
drill down several levels. A bookmark can be a snapshot of data that is “frozen” at a specific point in time, or it can 
be updated with current data when you access it. For example, you could create a bookmark to quickly access the 
System Overview on a particular host from last Wednesday.

You create a bookmark by navigating to the dashboard you want to bookmark, selecting Bookmark from the 
action panel, and then selecting options from the Bookmark dialog box. See the online help for the Bookmark 
dialog box for details.

Figure 2. The Bookmark dialog box.

The bookmarks you create are listed in the Bookmarks section of the navigation panel. When you select a 
bookmark, it appears in the display area.

To email a link to a bookmark:
1 In the Bookmarks area of the navigation panel, select a bookmark to display it.

2 Select Email from the action panel. An email window opens, containing a link to the bookmark.

3 Fill in the required information and click Send.

To delete a bookmark in the navigation panel:

1 Place the cursor over the dimmed delete icon beside the name of the bookmark. The icon turns red: .

2 Click the delete icon.

3 On the confirmation dialog, click Delete to delete the bookmark.

IMPORTANT: Setting bookmarks requires the Action Panel. The Action Panel is not visible in the default 
Foglight UI configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to 
Opening the Foglight classic Web Console
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Opening a New Window
Opening a new window instead of using the current browser is useful, for example, when you want to open a link 
or print a document, such as a PDF. When you use a new window, the document downloads or prints in the 
background and you are prevented from accidentally closing the browser window when closing the PDF. 

To open a new window:
1 Click the New Window link in the action panel to open a new browser window and change the URL to 

create a sub-session. 

2 Navigate and click on the sub-session tab to reload the new browser window or tab independently of the 
source session.

Running a Report
You can run, create, and manage your reports from any dashboard. The Reports menu is available on the top right 
corner of a dashboard. Some dashboards have an associated report template displayed at the top of this menu. 
For example, open the hosts dashboard. The All Hosts Report template is listed. In addition, if a user has created 
reports based on a dashboard and allowed your user role access to it, these reports are also listed in the Reports 
menu for that dashboard. For more information on reports, see Reporting on Your Enterprise on page 75.

Figure 3. The Monitored Hosts dashboard with the Report menu selected.

Choosing a Home Page

You can choose any dashboard and make it your personal home page. Other dashboards can also be designated 
as home pages by a dashboard developer. These are listed under Homes in the navigation panel.

To set your personal home page:
1 Select any dashboard in the navigation panel on the left. Choose the dashboard that is most appropriate for 

your needs.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 Click Make this my home page in the action panel. 

The dashboard is listed under Homes in the navigation panel and will be the first page that Foglight 
displays every time you log in.

IMPORTANT: Setting a home page requires the Action Panel. The Action Panel is not visible in the default 
Foglight UI configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to 
Opening the Foglight classic Web Console.
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If you later choose another dashboard as your home page, it replaces the previous one.

Getting Started FAQ
When I log into Foglight, why I do not see any dashboards in the navigation panel?
Foglight controls access to dashboards and views by means of roles. Your Administrator assigns users to groups 
and then assigns roles to those groups.

If you do not see any dashboards in the navigation panel, the user you signed in as may not have been assigned 
to a group. Contact your Administrator for assistance.

What determines which dashboards and views I can access?
When you try to access a dashboard or view, Foglight matches the roles of the groups to which you belong against 
the relevant roles and the allowed roles that were set for that dashboard or view.

Relevant roles control which dashboards and views are listed in the navigation and action panels. Allowed roles 
control which dashboards and views a group can access. In some dashboards, one or more views may not be 
available because your roles have not been set as allowed roles for them.

If I navigate away from a dashboard, do I see the same views when I return?
Yes. If you leave a dashboard and then return to it, you see the last views that were displayed.

Working with Dashboards
This group of topics describes how to work with Foglight dashboards and provides an overview of the common 
elements that are found on most dashboards.

Introduction to Views and Dashboards
Foglight uses views to group, format, and display monitoring data.

Dashboards are top-level views that do not need to receive data from other views. Dashboards typically contain a 
number of other views that display monitoring data. You access dashboards using the navigation panel.

Foglight includes a number of monitoring views and dashboards. You can also create and edit your own custom 
views and dashboards.

For information about common elements that are found on most dashboards, as well as creating your own custom 
views and dashboards, see the following topics:

• State Indicators

• Severity Indicators

NOTE: You can have multiple homes. When you mark something as a home page, it becomes the default 
home and it is added to the list of possible homes. For example, if you add the My Services dashboard as 
your home page, Foglight adds it to the your default set of homes and it becomes your current home. If you 
log out and log back in, you will access the My Services dashboard.

Table 1. The Operator and Advanced Operator roles have the following permissions:

This role: Has these permissions:
Operator Access to basic dashboards. Operators can also access dashboards like My 

Services, Agents, and Hosts.
Advanced Operator Extends Operator to include dashboards like the Service Builder.
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• Availability Indicators

• Tooltips, Dwells, and Popups

• Drop-Down Lists and Trees

• Customizer

• Exporting Data from Charts and Tables

• Common Views

• Switching to Console Mode

• Creating a Custom Dashboard

• Customizing Dashboards

• Working with Charts

Screen Elements
This section describes the Foglight screen elements that you can see regardless of which cartridges have been 
installed.

In addition to the display area and the two panels, a typical screen in Foglight includes other elements, which are 
indicated in the following graphic.

Figure 4. Elements in a typical screen.

For more information, see the following topics:

• Navigation Panel

• Display Area

• Action Panel

• Zonar and Time Range
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• Close Arrows

• Header

• Search

• Reports Menu

Navigation Panel
The navigation panel contains all the dashboards that you can access based on your role. On the left side of the 
page, hover your mouse over the arrow to view the list of available dashboards. Expand a module and select a 
dashboard to view it in the display area. The navigation panel can be edited to show only the modules that interest 
you. You may search the navigation panel to show only dashboards matching the entered string. 

When you move your mouse away, the navigation panel closes to give you a full view of the dashboard contents. If 
you want to keep the navigation panel open, click the arrow on the left of the display area. To close the panel, click 
the arrow again. See Close Arrows.

Foglight remembers the state of the navigation panel between logins, so if you make changes to the navigation 
panel when you log out, those changes will persist the next time you log in.

Editing the Navigation Panel
Use the navigation panel’s Edit Mode to show only the dashboards that interest you. Changes made to the 
navigation panel will persist after logging out. 

To edit the navigation panel:

1 On the Foglight navigation menu, click the Edit Mode icon .

2 Next to each module you want to hide, click the Hide/Show icon . 

3 Hidden modules are displayed in a darker gray. To view any hidden modules, click the Hide/Show icon 

.

4 When finished, click the check  to save. 

Navigation Search
The search function in the navigation panel allows you to easily find modules and dashboards containing your 
search string. 

As you begin typing, the items displayed in the navigation menu will be filtered to match your search. To cancel the 

search, click the  in the search field.

Opening the Foglight classic Web Console
Some actions require controls not present in the new Foglight interface. To use these functions, you must open the

Classic Foglight web console.

To open the Classic Foglight web console:

1 On the Foglight navigation menu, click the Open Foglight classic web console icon .

The Classic Foglight web console will open in a new tab.

NOTE: If you do not see any dashboards in the navigation panel, the user you signed in as may not 
have been assigned to a group. For more information, see Getting Started FAQ.
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Action Panel

The action panel lists the various actions that you can perform on the current dashboard. It also lists views and 
data that you can add to a dashboard or report that you are creating and provides access to the online help.

On the right side of the page, hover your mouse over the arrow to view the list of the available actions. When you 
move your mouse away, the action panel closes to give you a full view of the dashboard contents. If you want to 
keep the action panel open, click the arrow on the right of the display area. To close the panel, click the arrow 
again. See Close Arrows.

Foglight remembers the state of the action panel between logins, so if you collapsed the action panel when logging 
out, the panel is collapsed the next time you log in.

Tabs
The following tabs are available in the action panel:

• General tab—contains a number of actions that you can perform on the current dashboard or report, as
well as other actions you can perform (such as opening a new window or creating a new dashboard or
report).

• Design tab—provides access to design the display area, including area definition, layout, and context.

• Help tab—provides access to the online help and a search field for the help.

When you are working with a custom dashboard or report template, two more tabs appear:

• Views tab—add a view from the list to your report or dashboard by dragging it to the display area. See
Adding a View Using the Drag and Drop Functionality for more information.

• Data tab—display a data object in a view (that Foglight adds to your dashboard) by dragging the object into
the display area. See Adding a View Using the Drag and Drop Functionality for more information.

Close Arrows
The Close arrows are used to conserve space on the display area. Click the arrows to: 

expand  the display area and collapse  the navigation panels.

Header
Figure 5. The Foglight header

IMPORTANT: The Action Panel is not visible in the default Foglight UI configuration. To view the Action 
Panel, you must open the Classic Foglight interface. Refer to Opening the Foglight classic Web Console

Table 2. The header contains the icons described in this table.

Icon Description
The Foglight logo.

Search Type a search string to see hits in all Monitored Objects. For more information, 
see Search.
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Search 
The Search field, located in the header, is a global search tool which allows you to search for any monitored object 

To complete a global search:
1 Type a search string into the search text box.

Figure 6. A list of results is displayed.

2 Select an entry to view the search result. 

Clicking an entry opens a dashboard associated with the monitored object. If the object is not associated 
with a specific dashboard, a summary view opens to display the metric details for that object.

Reports Menu
You can run, create, and manage your reports from any dashboard. On the top right corner of the dashboard is a 
reports menu. Some dashboards have an associated report template displayed in the top of this menu. For more 
information on reports, see Reporting on Your Enterprise on page 75.

 username
Displays your user name. Clicking the icon or the arrow, two sub items will be 
displayed, Preferences and Sign out.

• Click Sign out to log out Foglight. When you log out, Foglight reclaims all
resources used in the current session.

NOTE: This is the recommended way to exit Foglight, rather than just closing the 
browser.

 Information icon
Displays the general information for Foglight, including the following sub items:

• Help: Click the item to access to the online help and a search field for the
help.

• Quest Support: Click the item to access to the Support Bundles page.
• Send Feedback: Click the item to access to the Contact Us information on

Quest company website.
• About: Click the item to display the version information, copyright

information, as well as Legal Notices and Contact information.

NOTE: If you have the cartridge developer role, you can also view Web Component Framework (WCF) 
search hits listed under the Definitions category.

Table 2. The header contains the icons described in this table.

Icon Description
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Display Area
The display area is where you view dashboards or reports and work with elements in your custom dashboards and 
reports. See Creating a Custom Dashboard and Building a Custom Report Template for more information.

Zonar and Time Range
Foglight controls the current time range using a special control called a zonar. See Time Range for more 
information. The default time range is the last 4 hours. 

Time Range Freeze Control
You can freeze the data Foglight displays at a specific time range to diagnose problems that occurred during that 
interval. See Freezing a Time Range for more information.

Time Range
The time range at the top of a dashboard indicates the current time range for all the views on the page. You can 
override the default current time range setting (the last 4 hours), by choosing another interval in the User 
Preferences page. For more information, see Setting Your User Preferences. 

By default, the time range in a dashboard is displayed in real time. You can freeze the time range so that the data 
Foglight displays in the views reflects a certain interval. When the time range is frozen, the views do not display 
new data. Freezing the time range helps you diagnose problems that occurred during a specific interval. For 
further details, see Freezing a Time Range.

Changing the time range in a dashboard normally affects all the views in the dashboard. If an individual view in a 
dashboard has a different time range, that takes precedence over the time range for the dashboard.

Click the time range (shown below) to access the timeline and calendar options, which allow you to specify a new 
time range.

Figure 7. Time range.

Timeline 
Click the Timeline option in the time range to:

• Select a pre-defined time range interval, from the last hour to ‘all time’.

• Specify a custom time range using a sliding bar called the zonar.

Figure 8. The sliding bar called the zonar.

Hover the cursor over the zonar to cause a popup to appear that displays the dates and interval (number of hours 
or days) spanned by the time range.

TIP: Maximize the size of the display area by closing the navigation panel.

NOTE: If some of the views contained in a dashboard have independent time ranges, Foglight does not 
display the time range.

NOTE: The time range for a summary view is likely to be different from the time range for a detail view. 
Therefore, the time range that you select affects only the current view and drill-downs from it; it does not 
affect higher-level views.
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Figure 9. Popup displaying the dates and interval spanned.

Using the zonar
Click the middle of the zonar to drag it to the left or the right. The start and end times of the range changes, but the 
total interval it spans stays the same. 

Increase or decrease the interval by clicking and dragging one side of the zonar. As you drag, the popup displays 
the new time range.

As you drag the edges of the zonar, the timeline scale adjusts automatically, increasing or decreasing the units of 
time.

If you drag the right edge of the zonar when the time range is in real time (the word Now is shown in the time range 
display), the interval persists and not the specific date and time to which you set the zonar.

Calendar
Use the calendar options to set a specific time range by specifying the time and date from which and to which you 
want the range to span.

To adjust the time range using the calendar options:
1 On the left side of the time range, click Calendar.

2 Use the From and To fields to set the time range:

a Click the calendar icon ( ) in the From field to set the starting point for the time range. 
Alternatively, select Earliest available.

b If you clicked the calendar icon: in the calendar popup, select a date and specify a time. Click 
above the field to close the popup.

c Click the calendar icon ( ) in the To field to set the end point for the time range. Alternatively, 
select Current time.

d If you clicked the calendar icon: in the calendar popup, select a date and specify a time. Click 
above the field to close the popup.

3 Set the Granularity. See About granularity for more information.

4 Click Apply to update the views based on the new time range.

About granularity
Granularity controls the size of the metric intervals. The default option is Raw, which displays the actual collected 
data points. The Auto option uses intervals that are sized according to the time range. For example, a one-hour 
range has five-minute intervals, while a one-week range has one-hour intervals. Ranges from 1 minute to 1 week 
are also available.

If you set too large an interval, there may not be enough points to plot on a chart. For example, if you only have 
one day of data, an interval of six months results in a single point. If an interval is too small, there may be too many 
data points to display if the chart is small.

The maximum and minimum values of a metric are actual numbers, while data points inside an interval are 
averaged. Agents may report their data at uneven intervals. Foglight sets the data to be plotted in evenly-spaced 
intervals using data collected from any number of agents.

To do this, the data points inside the interval are averaged. This has the effect of evening out the maximum and 
minimum values if an interval contains more than one real data point. The maximum and minimum values of a 

NOTE: If you enter an invalid date or time, a red exclamation mark appears and you 
cannot apply your changes.
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metric are based on real data and not an averaged value. These values are often plotted as markers on the chart. 
Therefore the averaged values on the plotted curve or bar may not match the real values of the markers.

To select a granularity value:
1 In the Calendar, select an option from the Granularity menu on the right side of the interface.

2 Click Apply.

Freezing a Time Range
By default, the time range on a dashboard is displayed in real time. You can tell this at-a-glance if the word Now is 
shown in the time range display.

Figure 10. The word Now indicates that the time range is displayed in real time.

You can disconnect from real time and “freeze” a dashboard at a specified time range. When this occurs, the views 
on the dashboard will not receive any new data. 

Some views show a frozen time range by default. This type of time range is called a diagnostic time range. See 
Diagnostic Time Range for more information.

To freeze a time range:
1 Select the dashboard for which you want to freeze the time range. 

2 Click the  icon to the left of the displayed time range at the top right of the dashboard. 

The time range is set and the icon changes to . 

Hover over the icon to display the message: Time range is in the past, click to switch to real time.

3 If you later refresh a dashboard, you may notice that the time range remains fixed even though the time 
that is displayed in the zonar changes. 

Figure 11. For example, the time range ends at 10:01, but the current time is later.

To unfreeze a time range:

• Click the  icon. 

The time range changes to end at the last monitoring time range that you used (for example, the last four 
hours).

Diagnostic Time Range
In some places in the Foglight browser interface, a diagnostic time range is calculated when drilling down on an 
item of interest. This most often happens when looking at the details of an alarm. By default, Foglight shows a four 
hour window, where the alarm time range is placed three hours into the window (that is, three hours prior and one 
hour past the alarm). The diagnostic time range stays frozen until you unfreeze (toggle) the time range.

The diagnostic time range function works as follows:

• For any alarm that is not in the current time range, clicking on a drill down places you into a diagnostic time
range.

TIP: When you hover over the icon a popup indicates if the time range is real time or frozen:
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• Some drilldowns indicate that you are in diagnostic time range as shown in the dialog box below.

Figure 12. The drilldown indicates that you are in diagnostic time range.

State Indicators
There are several different types of alert indicators used to represent monitoring data in Foglight. The types are:

• Severity Indicators

• Availability Indicators

The severity and state icons tell you about the condition of an application, server, or process. What they represent 
changes according to their context. They often represent a rolled-up state of the data collected on the object. For 
example, the same state icon can indicate that a server is down or that a process is down.

Many summary views show icons that represent an aggregation of the detailed objects of similar types. You can 
have Foglight prioritize the data when determining the aggregation by creating a service level agreement to do 
this. For example, if three test servers are down, and one production server is active, then a summary view would 
show a critical icon, not a fatal icon.

Depending on where it is, you can hover over a severity or state icon or click it to get further information about the 
condition it represents.

Severity Indicators
Severity indicators can indicate: 

• the severity level of alarms that have fired.

• the status of an object. For example, a domain, server, application, or process.

NOTE: The diagnostic time range function is not available for all drill-downs.

Table 3. Severity indicators:

Severity
Indicator Indicates... Description

Normal The component is operating within normal thresholds.
A normal severity level indicates that there have been no critical, warning, or fatal 
events fired. Foglight does not record events that are successful; it can only determine 
that there are no events that had problems.

Warning Represents a possible performance problem, based on calculations on current server 
metrics against best-practices thresholds.

Critical Indicates that the current metric values point strongly towards performance-related 
problems with the specified component.

Fatal There is a very strong indication that the server is experiencing conditions which will 
degrade performance.
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Availability Indicators
Availability indicators show the availability of a service.

Tooltips, Dwells, and Popups 
Different types of smaller views provide additional detail about an element in a view. Examples of these views are:

• A tooltip element describes what it represents when you hold the cursor over a status icon. A tooltip also
appears when you hover the cursor over a line in a chart (as shown below).

• A dwell displays additional information about the item when you hold your cursor over a line in a table.

• A popup displays additional information and options if you click a line in a table.

Tooltips and dwells disappear when you move the mouse, but a popup remains open until you close it by clicking 
outside it or clicking the close icon  in the corner. You can also maximize some popups by clicking the maximize 
icon  in the upper right corner.

Figure 13. Tooltips appear when yo uhover the cursor over a line in the chart.

Columns 
When you are creating a custom dashboard or report, you can choose one of the options under Columns under 
the General tab in the action panel to divide the display area into one, two, or three columns. 

Figure 14. Column options.

Table 4. Availability indicators.

Icon Description
Available

Not available
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Drop-Down Lists and Trees
Drop down lists are views that change the context of other views, such as those in the same container view. When 
you select an item from a drop down list, the view is refreshed with new data. For example, a view may contain a 
drop-down list of metrics, a chart, and a table. Selecting a different metric changes the context of the page, and the 
chart and table are updated accordingly.

A drop down displays a list of single options. A tree expands to display a hierarchy of options. Both can have the 
same effect on the context.

Customizer
Depending on how the chart was designed, the customizer icon  might appear when you hover the cursor over 
a chart or might always be visible. For example, on the Alarms dashboard, the customizer for the Alarm(s) table is 
always visible.

If the customizer icon is enabled you can:

• Select which columns you want to appear in a table.

• Change the chart type dynamically. See Changing the Chart Type.

• Export charts and tables to PDF, CSV, Excel, XML, or Image format. See Exporting Data from Charts and
Tables.

Exporting Data from Charts and Tables
The option to export data to PDF, Excel, CSV, XML, and Image formats are available for charts and tables.

For example, you can create new graphs using drag and drop metrics onto a dashboard, and then export the data 
to CSV output. Therefore, you can create multiple metrics, set a time range, export to CSV, and then open the data 
in Excel.

To export charts and tables:
1 Navigate to the chart or table you want to export. 

2 Click the Customizer icon  in the top right-hand corner of the table or chart.

3 Click Export.

4 Choose the format to export. 

5 Select a format and click Next.

6 If you have chosen to use the PDF format, you can customize the PDF report by completing any of the 
following steps:

a In the Title box, type a title for your report.

b In the Notes Before box, type a note to appear after the title of your report.

c In the Notes After box, type a note to appear after the exported view. 

d Click Yes to include a table summary of the data from the exported view.

e In the View Export dialog box, click Save as Report to save it to My Dashboard in the navigation 
panel, or click Export to view it in a separate browser window.

7 Select the metrics to export.

8 Click Export.

NOTE: Depending on the context, the customizer icon is also called the Edit or Options icon.
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Common Views
Foglight makes use of common views in most of the standard dashboards. Using common views in dashboards is 
an effective way to enable and create easy workflows. Examples of views used in many of the dashboards include 
the Alarm List and Host Summary.

Alarm List
The Alarm List view displays a summary of alarms. The Alarm list view allows you to examine alarms from different 
perspectives by choosing one of the following tabs:

• Alarms(s). See Viewing, Acknowledging, and Clearing Alarms.

• Error Instance(s)

• Related Host(s)

• Related Agent(s)

Expand nodes in these tabs and click on details to drill down and further investigate aspects of the alarms in your 
system.

For additional information the Alarm List view, see the following topics:

• Hiding Columns

• Alarm Chaining

• Historical Alarm Occurrences

• Alarm Notes

Error Instance(s)
An error instance is any object in your environment that is the source of an alarm.

Foglight lists each error instance’s health, number of alarms, and health history in the Error Instance(s) tab. 

Related Host(s)
You can isolate issues related to systems more easily by showing alarms organized by the originating host.

Foglight lists each host’s health, number of alarms, and health history in the Related Host(s) tab. 

Related Agent(s)
You can understand which agents are causing alarms to fire by showing alarms organized by the agent that 
collected the data. 

Foglight lists each agent’s health, number of alarms, and health history in the Related Agents(s) tab. 

Hiding Columns
You can hide any of the columns in the Alarms List view.

To hide columns:

1 Click the edit icon  above the table. 

A popup displays a list of the columns in the table.

2 Clear the check boxes for the columns you want to hide and click Apply. 
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The columns are removed from the table.

Alarm Chaining
An alarm chain is a series of consecutive non-normal alarm states for the same alarm event. For example, the 
CPU utilization on a specific machine keeps changing values that trigger a non-normal state. The following chain 
describes the alarm from 10:55 until 11:30 (when it becomes normal again)

10:55 AM – Normal

11:00 AM – Warning

11:05 AM – Critical

11:15 AM – Fatal

11:20 AM – Warning

11:25 AM – Critical

11:30 AM – Normal

Using the Alarm Details dialog box, you can choose either the Acknowledge or Acknowledge Until Normal option 
for a current alarm if you want the alarm to remain acknowledged until it reaches a normal state. For example, if 
you choose the Acknowledge until Normal option at 11:00 AM, the alarm stays acknowledged until 11:30 AM. In 
contrast, if you choose the Acknowledge option at 11:00 AM, the alarm (chain) would be “Unacknowledged” 
again at 11:05 AM when the severity has changed.

Historical Alarm Occurrences
From the Alarm Details dialog box, you can drill down to a view that shows historic occurrences of an alarm. For 
example, if you are looking at the CPU utilization alarm for host1, you can go to a view that shows historic 
occurrences of that alarm (CPU utilization) on the same object (host1).

To view historical alarm occurrences for an object:
1 On the Alarms dashboard, drill down to an alarm and click the alarm to display the Alarm Details dialog 

box.

2 On the Alarm Details dialog box, click Find Historic Occurrences.

Figure 15. The Alarm Historic Occurrences view appears. 

This view consists of the following main components:

▪ Time range menu: provides a quick way to change the current time range. Select an option in this
menu changes the current time range to the selected time period and updates the entire view. If
there is no alarm occurrence in the selected time period, nothing will be shown in the graph and in
the table.

NOTE: Alarm chains can only be seen in the Alarm Details dialog box. See Viewing Alarm Details for 
more information about this dialog box.
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▪ Alarm historical occurrences table: lists alarm occurrences in the current time range. The dwell and
popup on each row show the alarm severity transitions of the alarm occurrence in that row. The
Notes column shows the number of notes added to each alarm occurrence. Details of these notes
are available through the dwell and popup.

▪ A set of alarm occurrence controls: these controls show “>> No more occurrences” if there are no
occurrences outside of the current time range. If there is a “<< Get more” control on the left, this
indicates alarm occurrences prior to the current time range. Mouse over this control to show the
creation time of the most recent occurrence before the current time range. Click on this control to
display this alarm occurrence into the table and at the same time adjust the current time range to
include this occurrence. The “>> Get more” control works the same way for alarm occurrences after
the current time range.

Alarm Notes
Alarm notes provide you with a handy way to record information about an alarm for all other users to view. For 
example, if you are managing alarms during an installation of Foglight and if an urgent alarm comes up, you can 
add a note to the alarm that you are checking if the back-up process may be causing the problem. The note, along 
with a username stamp and a timestamp, are attached to the alarm.

There are two ways to add notes from the Alarm Details dialog box, by using either the: 

• History tab. The Notes  icon in the Alarm History table is for maintaining notes attached to a particular 

alarm in the history table. Clicking the Notes  icon, takes you to the Alarm Notes dialog box.

• All Notes tab. New notes are automatically attached to the most recent alarm in the alarm history.

Creating an Alarm Note
Alarm notes consist of free-form, non-localizable text, a user name, and a timestamp.

To create an alarm note:
1 From the Alarm Details dialog box you can either: 

▪ In the History tab, click on the Alarm note icon. The Alarm Notes popup appears. Click Add.

▪ In the All Notes tab, click New.

2 In the Add Note dialog box, type a description of the note.

3 Click Add.

The description is added to the Alarm Notes dialog box.

Editing an Alarm Note
Only the creator of the note can edit the note.

To edit an alarm note:
1 From the Alarm Details dialog box, you can either: 

▪ Click the History tab, and then click the Notes  icon. The Alarm Notes dialog box appears.

▪ From the All Notes tab, go to step 2.

2 Click the Edit  icon.

3 In the Edit Note dialog, change the description of the note.

4 Click Submit.

The description of the note changes to the modified text.
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Deleting an Alarm Note
Only the creator of the note can delete the note.

To delete an alarm note:
1 From the Alarm Details dialog box you can either: 

▪ Click the History tab, and then click the Notes  icon. The Alarm Notes dialog box appears.

▪ Click the All Notes tab, go to step 2.

2 In the Alarm Notes dialog box, select the check box of the note(s) you want to delete.

3 Click Delete.

The selected notes are removed.

Host Summary
Click or hover the mouse over the name of a physical host to view a host summary popup or dwell.

Figure 16. Viewing a host summary popup or dwell.

A diagnostic time range is displayed at the top of the summary. This time range indicates the period during which 
the alarm was fired. It is usually in the past and is sometimes different from the time range that appears on a 
dashboard. For example, the following alarm occurred on Monday May 11th during a particular time range, while 
the date displayed on the dashboard is Tuesday May 12th. 
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Figure 17. A diagnostic time range is displayed at the top of the summary.

Click on items in the popup to drill down to more information about the host, its alarms, and its performance.

Drilling down from the popup retains the time range during which the alarm occurred. To go back to the monitoring 
time range you last used, “unfreeze” the range by following the procedures in Freezing a Time Range.

Switching to Console Mode
Switch to console mode if you want to maximize the space available in the Foglight browser interface. For 
example, when you want to focus on one dashboard in a small or non-standard display.

To switch to console mode:
1 Navigate to the dashboard on which you want to focus.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 Obtain the URL to the dashboard:

a Click General > Actions > Properties > Link to this page in the action panel.

b Copy the URL.

4 Paste the URL into your browser’s address bar.

5 Replace page with noc in the URL. For example:

http://host1.example.com:8080/console/noc/user:operator.1

TIP: Create a custom dashboard to focus on a single view. Add just that view to the dashboard and 
then maximize it (Options > Maximize in the top-right corner of the view). See Creating a Custom 
Dashboard for more information.
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6 Go to the new URL.

Foglight displays the dashboard in console mode. Any dashboards to which you drill down are also 
displayed in console mode.

To log out manually, exit console mode by following the instructions below.

To exit console mode:
1 Delete everything after console from the URL. For example, if the URL is 

http://host1.example.com:8080/console/noc/user:operator.1, change it to the following:

http://host1.example.com:8080/console/

2 Go to the new URL.

3 Log in to Foglight.

Foglight displays your home page in standard mode.

Creating a Custom Dashboard
In addition to using the dashboards that are supplied with Foglight or created by dashboard developers in your 
organization, you can create custom dashboards for your specific needs. These dashboards can contain any 
combination of tables and charts that you find useful. 

As with creating a custom report, the custom dashboards that you create are located under My Dashboards in the 
navigation panel.

To create a dashboard:
1 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

2 On the action panel, click Create Dashboard.

The Create Dashboard wizard appears.

3 Choose to base your custom dashboard on one of the following options:

• Use All Data—start with a blank dashboard and build it by selecting discrete components from your
database. See Creating a Custom Dashboard Based on All Data.

• Start with a service—build a dashboard based on components of the service you select. See Creating a
Custom Dashboard Based on a Service.

• Create a Custom Dashboard based on the current dashboard—use the data shown on the current
dashboard to build a custom dashboard. See Creating a Custom Dashboard Based on the Current
Dashboard.

When you finish creating your custom dashboard, you do not need to save it. It is automatically available under My 
Dashboards in the navigation panel.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See How to create custom Foglight 
dashboards.

NOTE: This option is disabled if no dashboard is currently selected. To choose the 
dashboard to be used as your starting point, select the name of that dashboard in the 
navigation panel.

TIP: You can create a custom dashboard or report using parameterized input values. By using 
Parameterized Input Values you can quickly redefine what data is displayed in your custom dashboard 
or report at any given time. See Using Parameterized Input Values.

http://eDocs.quest.com
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Creating a Custom Dashboard Based on All Data
You can construct a custom dashboard based on all Foglight data by selecting any data available. Foglight 
provides you with a blank display area to which you can add any elements you want.

To create a dashboard based on all data:
1 In the Create Dashboard wizard, Build a Dashboard page, select Use All Data.

2 Click Next.

The View Properties page appears. See Setting View Properties.

Setting View Properties
To set view properties:

1 In the Create Dashboard wizard, View Properties page, type a unique name for the dashboard in the Name 
field. This is the only information required to create a new dashboard. 

2 Select one of the following Auto Refresh Rate options:

▪ 300 seconds (default rate value)

▪ Every x second(s)—type the number of seconds in the box to indicate the length of the refresh
interval

▪ Never

3 Optional—by default, if you do not select any relevant or allowed roles, the dashboard is available to all 
roles.

You can select specific roles to control access to your dashboard. However, the interaction between 
relevant roles and allowed roles is complex. Consult your organization’s dashboard designer or your 
Administrator for details.

Click the edit icon  beside Relevant Role(s) and/or Allowed Role(s) and select the appropriate roles.

▪ Relevant Role — Select the roles that allow existing dashboard users to view a dashboard. The
Relevant Role applies to a user who has several roles, such as Dashboard Designer or Foglight
Security Administrator. Selecting the Operator role allows anyone with this role to access the new
dashboard.

▪ Allowed Role — Determines which user role is allowed to see the dashboard. Leaving the role set
to the default ‘all’ allows all roles to access the new dashboard.

4 Optional — Click the edit icon  beside Background Image and select a background image to use for 
your custom dashboard. See Using a Map or Diagram as a Background Image.

5 You can enter a description of the dashboard in the Help text box. This text appears in a tooltip when you 
hover over the dashboard name in the navigation panel.

6 Select the Allow this dashboard to be included in other dashboards check box if you want to include 
this dashboard in other custom dashboards.

7 Click Next. 

The Select Dashboard Layout page appears. See Setting a Dashboard Layout.

IMPORTANT: Creating dashboards requires the Action Panel. The Action Panel is not visible in the default 
Foglight UI configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to 
Opening the Foglight classic Web Console
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Setting a Dashboard Layout

To set a dashboard layout:
1 In the Select Dashboard Layout dialog box, select an option to control the size and placement of 

information:

▪ Single-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into one column.

▪ Two-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into two columns.

▪ Three-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into three columns.

▪ Fixed Size—gives you access to the Edit Page Layout option where you can precisely position the
views. For more information, see Editing the Page Layout.

2 Click Finish.

Next, you can customize your dashboard by adding data and view elements to it. See Customizing 
Dashboards.

Creating a Custom Dashboard Based on a Service
You can construct a custom dashboard based on a service by selecting any service in Foglight. Foglight provides 
you with a blank display area to which you can add any elements you want.

To create a custom dashboard based on a service:
1 In the Create Dashboard wizard, Build a Dashboard page, select Start with a service.

2 Click Next.

Figure 18. The Select a service page appears.

3 Optional—select the Parameterize this dashboard check box if you want to create a dashboard that is 
designed to run with any service. 

4 Optional—when Parameterize this dashboard is selected, click the advanced checkbox to choose a 
data type for any of the services listed. This enables you to reduce the scope of the report to a particular 
data type. 

NOTE: You do not need to save your dashboard when you finish making changes. It is automatically 
available under My Dashboards in the navigation panel.
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5 From the table, select a service and then click Next.

The View Properties page appears. See Setting View Properties.

Creating a Custom Dashboard Based on the Current 
Dashboard
You can create a custom dashboard based on an existing dashboard by selecting any dashboard in Foglight as 
your starting point. Foglight provides you with a blank display area to which you can add any elements you want.

To create a custom dashboard based on the current dashboard:
1 On the navigation panel, select a dashboard to use as your starting point.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 On the action panel, click Create Dashboard.

4 In the Create Dashboard wizard, Build a Dashboard page, click Create a Custom Dashboard based on 
the current dashboard.

5 Click Next.

Figure 19. The Select objects page appears.

6 Optional—select the Parameterize this dashboard check box if you want to create a dashboard that is 
designed to run with any different instances of the specified parameters, which can be passed in from 
another view that is drilling into this one. 

7 Optional—when Parameterize this dashboard is selected, click the advanced checkbox to choose a 
data type for any of the services listed. This enables you to reduce the scope of the report to a particular 
data type.

8 From the table, select an object, and then click Next.

The View Properties page appears. See Setting View Properties.

TIP: If you later decide to add more views or data elements to your custom dashboard using the drag 
and drop functionality, see Using Parameterized Input Values.

TIP: If you later decide to add more views or data elements to your custom dashboard using the drag 
and drop functionality, see Using Parameterized Input Values.
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Creating a Report Based on a Custom Dashboard
You can create a report based on a custom dashboard and schedule that report to generate at a specific time. For 
example, you have access to a custom dashboard which is monitoring the memory usage for a Host machine that 
has been experiencing memory leak problems the past several weeks; you want to send a report to several 
interested parties to inform them about the progress of performance for this particular host. To do this, you can 
quickly create and schedule a report based on this custom dashboard.

To create a report based on a dashboard:
1 On the navigation panel, under Dashboards > My Dashboards, open the custom dashboard on which you 

want to base your report.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 On the action panel, open the General tab, and click Other Actions > Reports > Createa New Report.

4 If your custom dashboard does not use parameterized input values, click Convert the current dashboard 
into a report and then click Finish.

You can now run the report or schedule the report. See Running a Report or Scheduling a Report. 

5 If your custom dashboard uses parameterized input values, click Create a Report based on the current 
dashboard and click Next.

In the Select Options page, choose one of the following options:

▪ Direct Copy—copy all of the parameterized inputs and report-compatible views from the current
dashboard to the new report. If you have selected this option, click Finish. The report is displayed in
the display area. You can now run or schedule the report. See Running a Report or Scheduling a
Report.

▪ New report with selected inputs—create a blank report and use a selection of the custom
dashboard’s parameterized input values. If you have selected this option, select which
parameterized input values you want your report to use, and then click Finish. The Add View wizard
appears. See Adding a View and Using Parameterized Input Values.

Customizing Dashboards
You can add data to your custom dashboard and change the way it is displayed.

For more information, see the following topics:

• Adding a View

• Editing a View

• Adjusting View Options

• Working with Charts

• Adding Text

• Editing the Page Layout

• Using a Map or Diagram as a Background Image

• Editing Properties

• Deleting a Custom Dashboard

TIP: Watch the tutorial on how to use parameterized input values. From the toolbar in your 
report, click Show Tutorial.
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Adding a View
The Add View wizard is provided for the same function as creating a custom report.

To add views using the Add View wizard:
1 If the dashboard is not already opened, select the dashboard from the My Dashboards node.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 On the Action panel, open the General tab, and click Add view.

The Add View wizard appears.

4 Follow the instructions in Adding a View.

Adding Text
You can use the Add Text option, found on the General tab of the Action panel, to add text to your fixed position 
layout custom dashboard. The Add Text option allows you to set a font style for your text, specify a background 
image for the portlet view, and to configure an action for the portlet view. For example, you can configure the action 
to display a popup view when the user clicks on the text.

Figure 20. A text field with a background image specified.

To add text to a fixed position layout dashboard:
1 If the dashboard is not already opened, select the dashboard from the My Dashboards node on the 

navigation panel.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.
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3 On the Action panel, click the General tab, and then click Add text.

The Entering User Text dialog box appears.

4 Choose to:

▪ Change the text Style (for example, Heading 1)

▪ Type the Text to appear on the dashboard.

▪ Add a Background Image.

For more information, see Using a Map or Diagram as a Background Image.

5 Click OK.

6 Next, position the text on your dashboard. 

a Click the customizer icon on the top right corner of the portlet view and then click Edit Layout.

b Click the text view header and drag the portlet view to the position you want the text to appear on 
your custom dashboard.

c Click Done.

7 Optional—configure the portlet view to complete an action. For example, specify the action to be a popup 
view, of the outstanding alarms associated with a view in your custom dashboard, when the user clicks on 
the text.

a Click the customizer icon on the top right corner of the portlet view and then click Edit 
Properties.

The Config Portlet dialog box appears.

b Click the Action tab, select the check box for the text, and then click the edit icon .

The Configure Flow Action wizard appears.

c Follow the wizard instructions. For more information, see To configure actions:

Using a Map or Diagram as a Background Image
In conjunction with the fixed position layout custom dashboard, you can set the background to a geographical map 
or diagram and then precisely position views on top of it to represent the monitored state of objects at specific 
locations.

Use the Edit View Properties dialog box to upload a background image, such as map of a support or sales region 
or a diagram of your server rack.

To customize your dashboard to represent physical locations:
1 On the navigation panel, under Dashboards, open the fixed position layout custom dashboard.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 Select General > Actions > Properties > Edit basic properties from the action panel. 

The Edit View Properties dialog box appears.

4 Click the Background Image icon ( ).

TIP: Quickly add a map as your background image by selecting one of the map images that are 
included with Foglight from Dashboard Development > Support > Maps > Base Theme.
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The Select an Image dialog box appears. 

5 Enter the URL for the image or navigate to the image in the tree provided or click Upload image to specify 
your own image to use a background. If you have specified your own image, a My Definitions directory for 
your user account is added to the tree. Each additional uploaded image is added to this directory.

6 Preview the image and click OK.

7 Place monitoring views at specific locations by dragging data or views onto your image. For more 
information, see Adding a View Using the Drag and Drop Functionality.

Editing the Page Layout
If you chose the Fixed Size layout option in the Setting a Dashboard Layout dialog box, use the Edit page layout 
dialog box to position your view exactly where you want it.

You can also resize the view to fit the space you have available on the screen or change the view’s display options.

To edit the layout of your dashboard:
1 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

2 Select General > Actions > Edit page layout from the action panel.

Foglight displays the views within dashed line borders to indicate that they are selectable.

3 Click a view to cause the edit mode popup to appear.

4 Configure one or more of the following options:

▪ Size and Position—resize or change the co-ordinates of the view.

▪ Grouping—multi-select and group views that you have dragged onto the dashboard. For example,
drag and drop a metric view and a property view related to one of our hosts onto your dashboard,
select both, and click Group ( ) to group them together. You can then work with them as one
view.

Ungroup the view (for example, to remove one view from the group) by clicking Ungroup ( ) in the 
edit mode popup.

▪ Order—change the stacking order (bring the view to the front, back, forward, or backward).

▪ Display options—select different options depending on whether you want to show the view title,
show its border, or make it opaque.

5 Click Done at the top of the dashboard.

NOTE: When you group views, Foglight nests them as static views. This 
means that they do not change when the views from which they were 
copied change and Foglight does not update the data they display.

NOTE: You cannot edit the properties of grouped views.

TIP: Clear the Show Title check box when grouping views so that the new 
grouped view does not display multiple titles.
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Editing a View
You can configure your settings for your custom views. For example, you can edit metric views by changing the 
display type, selecting metric labels, configuring chart settings, and choosing the action that occurs when you 
select or dwell over a metric.

To edit a view:
1 Navigate to the custom dashboard that contains the metric view you want to edit.

2 If your dashboard uses a column-based layout:

a Click the Options icon ( ) at the top-right corner of the view.

b Select Edit properties.

The Config Portlet dialog box appears.

If your dashboard uses a fixed position layout:

a Open the Foglight classic web console to view the action panel.

On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

b Select General > Actions > Edit page layout from the action panel.

The views appear in dashed line borders indicating they are selectable.

c Click the particular view you want to edit.

A dialog box appears.

d Click the Edit  icon.

The Config Portlet dialog box appears. 

3 Make changes to your view. The options and tabs that are available in the Config Portlet dialog box vary 
depending on the type of view you are editing. For all view types, you can change the view title.

If an Options tab appears, the options that it lists vary depending on the type of view you have chosen. 
Note that certain views and display types do not have options associated with them. If there are options 
available, you can save your settings. The next time you create or edit a view, Foglight uses these settings 
for that particular view or display type as the default options for your user account.

If you are editing a table view: you can adjust the columns, filter the data you selected based on rules, 
and configure actions. See Step 1 in Adding a Table View, Filtering a List, and Actions tab.

If you are editing a property view: you can make changes to the property list or renderer and configure 
actions. See Step 8 and Step 9 in Adding a Property View and Actions tab.

If you are editing a metric view: you can make changes to the following:

▪ Title—rename the view.

▪ Height—set the height for all views or this view by selecting the check box and specifying a value.

▪ Display type—select the visual display. For more information, see Display type tab.

▪ Metrics—choose the metric labels for the chart. For more information, see Metrics tab.

▪ Options—configure settings according to the display type. For more information, see Options tab.

▪ Actions—set what happens when a user interacts with the view. For more information, see Actions
tab.

4 Click Apply when you are finished editing your view.

NOTE: The options that are available on the Config Portlet view depend on the type of
view you are editing. The options listed in step 3 are only an example.
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Display type tab
The Display type tab contains options where you can select the visual layout according to a chart type, gauge type, 
or list type. For more information on the display types available and their settings, see Options tab.

Metrics tab
Use the check boxes in the Metrics tab to select the metrics that you want to appear in your view.

Options tab
The following tables lists the options available depending on the display type:

• Charts

• Gauge

• List

Table 5. Charts Table:

Icon Name Setting Description Option/Limits
Plot (draws each 
series as a line 
graph)

Area (draws each 
series as 
connected points 
of data, filled 
below the points)

Stacking Area 
(draws each 
series as a 
stacked cluster)

Bar (draws each 
series as a bar in 
a cluster)

Line Width Specifies the thickness 
of lines in all charts or 
this chart.

• Automatic
• Small
• Medium
• Large

*available for Plot chart only
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Metric Value Controls the type of 
value that is displayed 
for one metric or all 
metrics in a chart.

• None
• Average: The chart

displays the average
value for the metric per
interval.

• Minimum: The chart
displays the actual
lowest value for the
metric per interval.

• Maximum: The chart
displays the actual
highest value for the
metric per interval.

• Minimum/Maximum:
The chart displays the
maximum and
minimum value for the
metric per interval.

• Sum
Show one 
chart per 
metric

Indicate if you only want 
to display one chart per 
metric.

Check box

Only show 
axis of 
selected 
metric 
(different 
charts will line 
up)

Select this option to 
show only the axis for 
the selected metric. For 
an example, see 
Grouping Metrics with 
Many Parent Hosts.

Check box

Show 
thresholds for 
selected 
metric

If a metric has a 
threshold, it is 
displayed.

You can choose to show 
thresholds only for the 
selected metric. 

Show data at 
both start and 
end of 
intervals

Applies only to plot and 
area charts.

Check box

 Bounds Sets the chart axis so 
that it does not go out of 
chart boundaries.

Selected by default.

Table 5. Charts Table:

Icon Name Setting Description Option/Limits
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Show Overall Displays the overall 
value for the set time 
range as a dashed line.

• Average displays the
overall average.

• Min displays the
overall minimum.

• Max displays the
overall maximum.

Show Min/Max 
As

Displays the minimum 
and maximum per 
interval.

• Envelope (a filled-in
area between the
minimum and
maximum)

• Marks
• Lines

Show Baseline 
Min/Max As

Displays the baseline 
minimum and 
maximum.

• Envelope (a filled-in
area between the
minimum and
maximum)

• Marks
• Lines

Show 
Standard 
Deviation As

Similar to the Min/Max 
setting; lets you 
highlight a range per 
interval. 

• Envelope (a filled-in
area between the
minimum and
maximum)

• Marks
• Lines

Standard 
deviation 
multiplier

Determine the high and 
low values by setting 
the deviation from the 
average.

The default value is 1, but the 
unit of deviation depends on 
the metric.

High/Low chart Show Average 
Line

Emphasizes the highest 
and lowest values.

Settings for the other type of 
chart types are not available.

Table 6. Gauge Charts

Icon Name Setting Description Option/Limits
Metric 
Indicator 

Indicator 
Size

Useful for highlighting a 
fluctuating value in your real-
time application in a visually 
meaningful way

• Normal
• Wider

Spinner N/A Represents data using a 
rotating wheel. 

No options.

Table 5. Charts Table:

Icon Name Setting Description Option/Limits



Foglight 7.1.0 User Guide 
Getting Started with Foglight 40

Actions tab
You can set the actions that occur when a user interacts with your view, such as its popup, dwell, and drill-down 
behavior. For example, you can configure an action so that a popup appears when a metric is selected.

Horizontal 
Bar

Bar 
Thickness

Horizontal bar, Vertical bar, and 
cylinder give you flexibility to 
present data in terms of a 
graduated scale

• Thinner
• Normal
• Thicker

Vertical Bar N/A No options.

Cylinder N/A No options.

Flow Gauge Sparkline 
options

Communication between host 
server components are 
represented by animated data 
flow that indicate the direction 
of the communication.

Show Sparkline: (check box)

Sparkline displays:
• Average
• Minimum
• Maximum
• Extreme

Flow Direction:
• Left
• Right

Prominence
• Less
• Normal
• More

Table 7. Lists Chart

Icon Name Setting Description Option/Limits
Metric List Show 

Sparkline
Displays a sparkline for each 
metric.

Check box

Table List Show 
Column 
For...

Display the columns you select. Check boxes for:
• Min (selected by default)
• Average (selected by default)
• Max (selected by default)
• Sum

• Baseline Min
• Baseline Max

• Standard Deviation

Table 6. Gauge Charts

Icon Name Setting Description Option/Limits
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To configure actions:
1 In the Actions tab, select the check box for the action you want to set.

2 Click the Select a metric check box to choose an action to describe how you want to show the next view. 

The Edit icon  is enabled. 

3 Click Edit . 

The Configure Flow Action wizard appears.

4 Select one of the following flow actions for Metric Selection:

Popup—displays a view as a simple popup that has no title bar or borders and can be dismissed by 
clicking outside of it.

Dialog—displays a view in an interactive window, which can be moved around or dismissed through its title 
bar.

Next Page/Drill Down—drill into or go to another page containing a view of your choosing.

External URL—displays a specific web page by specifying its URL.

5 Click Next. The Select a data item to use page of the wizard appears.

6 Select a data item to use from the following options:

No Data—select a view that does not require any particular data from the existing view.

Selected Metric Parent—select a parent of the metric selected from the chart.

Selected Metric—select the metric from the chart.

Metric Parents—select a parent from the list of parents of the metrics currently bound to the chart.

Metrics—select a metric from a list of metrics currently bound to the chart.

7 Click Next. The Choose a target view page of the wizard appears.

8 Select a view from the list on the left column and then click Finish.

▪ Optional—click the show by role check box to select a view for a particular role.

Adjusting View Options
You can make changes such as sharing a view, editing its properties, or maximizing it by clicking the Options icon 
( ) in the title bar. See Working with Views.

Removing a View
To remove the view:

1 Click on the particular view you want to remove.

2 On the Edit Page Layout dialog box, click the Remove  icon.

A confirmation dialog box appears.

3 Click OK to confirm that you want to remove the view.

The view is deleted from the dashboard.

Using Parameterized Input Values
Using parameterized input values for your custom dashboard or report allows you to redefine an input value during 
scheduling or at run-time. With parameterized input values, you can customize a dashboard or report at any given 
time.
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For example, you have a custom dashboard which is designed to monitor memory, storage disk, and network 
utilization, as well as space used, for a particular host. If you want to use the same custom dashboard to monitor 
another host, you can so quickly by resetting the parameterized input value defined in the Action panel, General 
tab, and Page Input value. 

To use parameterized input values for a custom dashboard:
1 On the navigation panel, under Dashboards > My Dashboards, open your custom dashboard.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 On the Action panel, open the Data tab.

4 Click the down arrow to expand the Parameterized Inputs and Data elements.

Figure 21. The down arrows expand the elements.

5 Select a data element, and then drag and drop it onto the Parameterized Inputs link.

Figure 22. Drag and drop a data element.

6 From the Parameterized Input list, select an element and then drag and drop it onto your dashboard.

7 To change the parameterized input values used in this dashboard, on the Action panel, open the General 
tab. 

8 Under Page Inputs, click the arrow to expand the parameterized input value. 

TIP: When using parameterized input values for a custom dashboard or a report, it is recommended 
that you select a node that is higher in the tree to be a parameterized input value, instead of using a 
specific metric lower in the node tree. By doing so, more parameterized input values are available to 
select from to customize your dashboard or report. 
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9 Remove the check mark from the Show Advanced option.

The other parameterized input values below the parent node are listed.

10 Select another value in the list. In this example, select another host to base this dashboard on.

The information displayed in this dashboard updates automatically. 

To use parameterized input values for a report:

1 On the navigation panel, under Dashboards > My Dashboards, open your custom report.

2 Complete Step 2 through Step 6 in the previous procedure.

3 To change the parameterized input values when you run a report:

a On the top of your report, click Run Report.

Figure 23. The Run Report pane.

b Click the edit icon and then remove the check mark for Show Advanced.

c Select a new report parameter to use as the input value when the report is generated.

d Type a report name, select a report format, and if required, add email addresses of those who you 
want to send this report to.

e Click Run.

4 To change the parameterized input values when you schedule a report:

a On the top of your report, click Schedule Report.

b Click the edit icon and then remove the check mark for Show Advanced.

c Select a new report parameter to use as the input value when the report is generated.

d Click Next.

e Select the schedule for when you want this report to run.

f Click Next.

g Type a report name, format, retained value, enable this schedule immediately, and if required add 
email addresses for any desired recipients of this scheduled report.

h Click Finish.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See Customizing Foglight Reports with 
Parameterized Inputs. 

http://eDocs.quest.com
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To remove a parameterized input value:
1 On the Action panel, open the Data tab and expand Parameterized Inputs.

2 Click the delete icon to remove the parameterized input value.

Deleting a Custom Dashboard
You can delete any custom dashboard that you have created. You may also be able to delete dashboards created 
by other users, although this is not recommended. You cannot delete any default dashboards or dashboards 
created by dashboard developers in your organization.

To delete a custom dashboard:
1 Select the dashboard that you want to delete from the list under My Dashboards.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The 

classic web console will open in a new tab.

3 Click Delete this page in the action panel.

A confirmation dialog box appears.

4 Click Delete to confirm the deletion.

The dashboard is removed from the My Dashboards list. 

Working with Charts
Add predefined charts to your custom dashboards and customize charts to access and analyze data provided by 
Foglight.

Charts display data graphically. Certain graphing behaviors that they possess result in data being interpreted 
rather than recorded. Start/end behavior, data granularity, treatment of data holes, line thickness, 
minimum/maximum versus average, and data envelopes all influence how data is interpreted and displayed in a 
chart. 

You can create a metric chart using: 

• The drag and drop functionality available with the metrics view in the Add View wizard (for creating a
dashboard or report) or

• The Data tab in the action panel to drag a metric onto a portal.

TIP: If you want data that cannot be misinterpreted, use a table. However, make sure you output 
min/max, average, count and standard deviation.
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Figure 24. An example of a metric chart.

You can also add one or more metrics to an existing chart.

• The metrics in the chart are indicated by differently colored lines.

• The line for the currently selected metric (by default, the first one chosen) is bold. To highlight other metrics
in the chart, click on the lines in the legend.

• When you hover over a line in the chart, a dwell indicates the name, unit, and value of the metric, as well as
the specific date and time when it was collected.

The y-axis shows the units for the metric. If there is more than one metric in the chart, the y-axis shows the units 
for the first metric that was charted, unless you have cleared the Only show axis of selected metric (different 
charts will line up) check box in the Options tab of the Add Metric View wizard (see Options tab for details). 

By using the Customizer function you have the option to export metric data for charts to PDF, CSV, Excel, XML, or 
Image format. See Exporting Data from Charts and Tables.

For more information about working with charts, see the following topics:

• Using the Metrics Analyzer

• Changing the Chart Type

• Zooming into a Chart

Using the Metrics Analyzer
For any custom dashboard visualization views that you create dynamically (drag and drop), there are built-in, 
default drilldowns available, so you can navigate to another view. You can use the metrics analyzer to view the 
data in different ways, by experimenting with metrics included in the same parent object.

To use the metric analyzer:
1 For any chart you have created, click on data in the chart.
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Figure 25. Charts for these metrics appear in the Metrics Analyzer view.

2 For any other indicators you have added to your custom dashboard, such as a spinner, click on the 
indicator, and then click Metrics Analyzer.

Figure 26. The Spinner metric appears in the Metrics Analyzer view.

3 Select the Individual Charts tab to display each metric individually, or click the Single Chart tab to view all 
selected metrics in a single chart.

4 To view the data in different ways, experiment with metrics available in that same object (metric parent). 
Select metrics from the Metrics Selector in the navigation panel.

Individual charts are added to the view.

Grouping Metrics with Many Parent Hosts
When you have many metrics from different parent hosts on a single chart, the parent label appears in the legend, 
as shown below.

NOTE: By default, advanced metrics are not displayed. To see all metrics belonging to a 
parent object, in the navigation panel, under Metrics Selector, select the Show All check 
box.
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Figure 27. Parent labels in the legend.

You can choose to display only the y-axis of the selected metric. This is useful when the metrics you are charting 
have different units or a wide range of values. See Editing a View for information about changing this option.

Changing the Chart Type
If the Customizer (sometimes referred to as Edit) icon  is enabled for charts, you have the option to dynamically 
change the chart to a different chart type (for example, bar, plot, area, stacking area). For example, switch the 
chart type to Area to emphasize the magnitude of change over time and illustrate the metric parts in relation to the 
whole graph.

To change the chart type:

1 Click the Customizer icon  in the top right hand corner of the chart.

2 In the Chart Type dialog box, click the chart type to change. 

The chart dynamically changes to display the selected chart type.

3 In the Bounds section, set the chart Y axis range. The following options are available:

▪ Use View Settings—based on the default settings for the current dashboard view.

▪ Automatic—based on a calculation of the metric’s data and unit.

▪ From Data—based on the Min and Max data values. For example, if the Min value is 10, and the
Max value is 90, the chart axis displays this range.

▪ Data vs Calibrated—based on the actual and expected values for Min and Max.

The chart dynamically changes to display the selected chart bounds option.

4 Select the metric to include in the export.

The chart dynamically changes to display the selected metrics.

To export the chart to CSV, PDF, Excel, or XML format, see Exporting Data from Charts and Tables.

Zooming into a Chart
For plot or bar charts, you can zoom into an area to view data at different levels of detail by using CTRL + drag. 
You can also drag on an axis to specify the region you would like to zoom into (a zoom region).

NOTE: Applying changes to a customizer in a view is only a temporary change. Once you exit the 
view, the default settings for the chart are applied.
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To zoom into a chart:
1 In a line graph, zoom in to the area of the chart. Select one of the following methods to specify a zoom 

region:

▪ press CTRL + drag on the area

▪ drag on an axis of the chart

2 The chart zooms into the range selected and will locally change the time range so Foglight displays all data 
points. Now you can view the data for the selected metric at a more granular level. 

To zoom out and return the line chart to its original view, click the Reset Zoom icon  in the top-right corner.



Foglight 7.1.0 User Guide
Viewing, Acknowledging, and Clearing Alarms

2

49

Viewing, Acknowledging, and
Clearing Alarms

Alarms are triggered when problems arise in your monitored environment. Foglight fires alarms when a rule 
determines that certain pre-defined conditions are met.

Use the Alarms dashboard to view the state of alarms across your monitored environment and take immediate 
action on them. The Alarms dashboard shows alarm counts by time, allowing you to identify excessive alarm 
counts or outage events. 

Input “Alarms” in the Search textbox on the Foglight Home page to access the Alarms dashboard.

Figure 1. The Alarms dashboard.

The Alarms dashboard shows the information of system alarms and changes, and facilitates the investigation of 
top issues in your environment. The Alarms dashboard includes the following elements:

• Alarms tab: See Alarm(s) for the Entire System and Viewing Alarms.

• Alarms Analysis tab: See Alarms Analysis.

• Blackouts tab: See the “Blackout Configuration” section in the Foglight Administration and Configuration
Help.

• Alarm Filter button: See Filtering the Alarm List.

Alarms Analysis
The Alarm Analysis view is to provide a snapshot of alarms and to help you investigate top issues in your 
environment, so you can more proactively manage your alerts, thresholds, and monitored system. The alarm 
count in this view includes SLA alarms. 

NOTE: This chapter discusses managing alarms from the Alarms dashboard, however alarm lists 
appear in many places throughout Foglight —for example, at the bottom of the My Services dashboard 
or in the popup that appears when you click an alarm in the Domains dashboard. You can view details 
about, acknowledge, or clear alarms in these alarm lists by following essentially the same steps 
described in this chapter.

TIP: You can also access this dashboard from the navigation panel: select Homes > Alarms.
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The maximum number of alarms for the selected time range is set to 5000 by default. To change this value, type 
the number in the Max Number of Evaluated Alarms field, and then click Apply. The Max Number of Evaluated 
Alarms is scaled from 0 to 100,000 and is managed by the Alarm_Analysis_Max_Object variable. To change the 
value of this variable, search for and edit Alarm_Analysis_Max_Object from Dashboards > Administration > 
Rules & Notifications > Manage Registry Variables. 

The Alarms Analysis (Preview) view contains the following elements:

• Alarms by Source: Lists all alarms (cleared or non-cleared) that are triggered by the alarm source. For
more information about alarm sources, click Dashboards > Administration > Rules & Notifications >
Rules.

Click an alarm source to display a popup and see more detailed information about an alarm. For more
information, see Viewing Alarm Details on page 51.

• Counts by Severity chart: Summarizes the totals for each severity of alarm (Warning, Critical, or Fatal) and
the total number of alarms.

• Alarms by Service: Summarizes the total alarms and agents that are not included in services, as well as all
alarms (cleared or non-cleared) that are triggered by services. For more information about services, click
Dashboards > Services > Service Builder.

Click a service to display a popup and see more detailed information about an alarm. For more information,
see Viewing Alarm Details on page 51.

Alarm(s) for the Entire System
At the bottom of the Alarms dashboard, the view lists up to 5000 alarms for the current or historical time range. It 
does not list SLA alarms. You can filter the list, sort it by column, or acknowledge and clear alarms.

The alarms list also shows cleared alarms and indicates whether an alarm has been acknowledged or cleared. 
Cleared alarms appear dimmed and can be filtered out using the Alarm Filter dialog box. To access the Alarm 
Filter dialog box, click Alarm Filter in the top-left corner of the list.

To see more detailed information about an alarm, hover over or click a column to display a dwell or a popup. You 
can select an alarm and investigate, acknowledge, or clear it.

The alarm list view allows you to select different perspectives on alarms. This chapter discusses using the 
Alarm(s) tab. For information about using the other tabs, see the User Help (navigate to Help > Help Contents > 
Using Foglight > Foglight User Help > Getting Started > Working with Dashboards in the action panel and 
then click Working with Dashboards > Common Views > Alarm List).

Viewing Alarms
This section discusses viewing alarms in more detail.

• Filtering the Alarm List

• Viewing Alarm Details

Filtering the Alarm List

You can filter the list according to different criteria by clicking  in the top-left corner of the list 
and changing the settings in the Alarm Filter dialog box.

NOTE: It is not recommended that the value of Alarm_Analysis_Max_Object is set to be larger than 100,000; 
otherwise the loading of the Alarm Analysis view will be unsatisfactorily slow. 
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Figure 2. The Alarm Filter dialog box.

For example, you can filter the list of alarms to show only Current or Historical alarms. Select Current to shows 
all outstanding alarms. This is essentially the current outstanding set of alarms that need to be addressed. Use 
Current if you want to see what is immediately noteworthy. In contrast to Current, Historical shows all alarms 
that fired during a certain interval, regardless of whether they are active or cleared. Use Historical if you want to 
see what is happening in your monitored environment during a specific time range.

In the Alarm Filter dialog box, you can also set a number of other parameters to help you filter the list, and you can 
set the maximum number of results to display in the table.

Viewing Alarm Details
To view details about an alarm, click its severity icon in the Alarm(s) list. Information about that alarm is displayed 
in the Alarm Details dialog box. Depending on how a rule is set up, the Alarms Details view varies. If the rule is set 
up with no associations to its Rule ID, the following view is displayed:

Figure 3. An example of the Alarms Details view.

This dialog box shows the alarm’s service level impact and its full history. The history includes all consecutive 
alarms fired by the same rule on the same object (instance) regardless of the dashboard’s time range. 

In addition, this dialog box displays a diagnostics and a recommended action message to assist you in resolving 
the problem. Click one of the provided links to display a drilldown page that will assist you in diagnosing the 
problem. For example, if an alarm is fired because the credentials were not established when trying to connect to 
a host machine, drilldown links to credential details are provided. Click the Diagnostics link to display the 
Credentials Query dialog box. From there, you can configure the credential query that triggered the alarm. Click 
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the Recommended Action link to display the Manage Credential dashboard. From there you can map each 
credential to one or more resources, choosing the parameters and patterning criteria that best suit your needs.

The Alarm Details dialog box also illustrates how the alarm has changed in the current alarm chain. See the User 
Help (navigate to Help > Help Contents > Using Foglight > Foglight User Help > Getting Started > Working 
with Dashboards in the action panel and then click Working with Dashboards > in the action panel and then 
click Working with Dashboards > Common Views > Alarm List > Alarm Chaining).

You can also drill down from this dialog box to investigate the severity of the alarm in more detail. For example, 
click the icon in the Service Level Impact table for information about the service whose Service Level Agreement is 
affected by the alarm. Performing impact analysis on an alarm helps you to determine the priority of the problem 
that caused the alarm to fire.

If an alarm has an association set up and is triggered by a rule, the following dialog box appears: 

Figure 4. An example of an Alarm dialog box.

This dialog box shows the summary, history, and source information to assist you in diagnosing the cause of an 
alarm. From here you can identify the objects (instances) affected, and review the suggested causes and potential 
solutions. The Diagnose button appears if the rule diagnosis property is set in the rule and the user has the 
appropriate role to access the Diagnose view. Click the Diagnose button to review the resource configuration for 
the alarm. The History/Notes tab displays the recent history and associated notes for that alarm. The Source tab 
displays details about the agent that collected the data and the associated rule. Users with the Administrator role 
can edit the associated rule. For more information about creating and editing rules, see the Administration and 
Configuration Guide.

Investigating the Alarm Source
In the Alarms table, the Instance field lists the object in your monitored environment that is the source of the alarm. 
Click the listing for an alarm source to display its health summary. The health summary shows the number of 
alarms by severity and the health of the alarm source and lists the agents and host associated with the alarm 
source. 

In addition, it provides a list of related views that show quick drilldowns to help identify the root cause. This list is 
based on the views that match the type of the alarm source. If no related views are available, then the default 
views (for example, Configuration > Data browser) are provided.
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Adding Alarm Notes
Using alarm notes is a handy way to record information about an alarm for other users to view. For example, if an 
urgent alarm comes up that you want to investigate, you can add a note to the alarm that you are checking if a 
certain process is causing the problem. The note is attached to the alarm along with your user name and a 
timestamp.

You can view, filter, add, and edit alarm notes from the Alarm Details dialog box. Use the History tab to attach 
notes to a particular alarm in the history table. Use the All Notes tab to attach a note to the most recent alarm in 
the alarm history. For more information, see the User Help (navigate to Help > Help Contents > Using Foglight > 
Foglight User Help > Getting Started > Working with Dashboards in the action panel and then click Working 
with Dashboards > Common Views > Alarm List > Alarm Notes).

Acknowledging an Alarm
The Ack’ed column displays No for any alarms that have not been acknowledged. Once an alarm has been 
acknowledged, this setting cannot be changed.

If you have the Advanced Operator role, you can acknowledge alarms. To acknowledge multiple alarms at once, 
follow the instructions in To acknowledge one or more alarms: on page 53. To cause alarms to remain 
acknowledged until the monitored object returns to a normal state, follow the instructions in To acknowledge an 
alarm until the alarm source returns to a normal state: on page 53.

To acknowledge one or more alarms:
1 Use the Alarm Filter to apply a filter on current or historical alarms.

2 In the Alarm(s) list, select the alarms that you want to acknowledge.

3 Click Acknowledge at the top of the table.

The current alarms are acknowledged and Yes is listed in the Ack’ed column for them. If the alarms fire 
again at a later time (usually because the condition has recurred), they appear in the list as 
unacknowledged.

4 Hover the cursor over Yes in the Ack’ed column.

A dwell appears that lists the alarm as acknowledged along with your user name and the time and date you 
acknowledged the alarm, Foglight also stores this information in an audit report.

To acknowledge an alarm until the alarm source returns to a normal state:
1 Use the Alarm Filter to apply a filter on current or historical alarms.

2 In the Alarm(s) list, click No in the row for the alarm.

The Alarm Details dialog box appears.

3 Click Acknowledge Until Normal.

The current alarm and all consecutive alarms fired by the same rule on the same object remain 
acknowledged until the first alarm fired after the alarm source returns to a normal state. Ack’ed til Normal 
and your user name appear in the Ack’ed Info column.

4 Close the dialog box.

In the Alarm(s) list,Foglight displays Yes in the Ack’ed column for the alarm.

TIP: Choose Acknowledge Until Normal if, for example, a series of alarms is due to a known situation. 
Anyone looking at the Alarms dashboard will know that this known problem has been acknowledged.

NOTE: This option is available for an outstanding (not-yet-cleared) alarm only.
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Clearing an Alarm
In most cases, Foglight clears an alarm when the condition or conditions that triggered the alarm changes. For 
example, an alarm fires when the CPU usage metric for a monitored host exceeds a certain threshold. If the value 
of the metric drops below this threshold, Foglight clears the original alarm. If the alarm condition occurs again, the 
alarm reappears.

If you have the Advanced Operator role, you can also manually clear alarms. However, you should only do so 
when alarms do not clear themselves—for example, for log messages or one-time events that generate alarms.

The Cleared column in the Alarm(s) list indicates whether an alarm has been cleared or not. In addition, cleared 
alarms appear dimmed. 

To clear one or more alarms:
1 Use the Alarm Filter to apply a filter on current or historical alarms.

2 In the Alarm(s) list, select one or more alarms that you want to clear.

3 Click Clear at the top of the table.

If you are filtering the list on current alarms, the alarms are removed from the list. If you are filtering the list 
on historical alarms, the alarms appear dimmed and Yes is listed in the Cleared column for them.

Alternatively, you can clear an alarm from the Alarms details dialog box. It appears dimmed in the dialog box when 
you have done so. If you are filtering the Alarm(s) list to show current alarms, the alarm is also removed from the 
list.
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Viewing, Creating, and Managing
Alarm Templates

Foglight uses alarm rules to define conditions that indicate problems in monitored systems. When these conditions 
are met, an alarm is triggered. 

Alarm templates allow you to configure a set of alarm rules and apply these rules in bulk to targets in your 
environment. Using a customized template, you can modify the threshold values for triggering alarms, and enable 
or disable certain alarms for a set of targets. 

Use the Alarm Templates dashboard to view the alarms and rules in the default factory template and customize 
those alarms as required for your environment. 

For better understanding of Alarm Templates, review the concepts below:

Alarms
Foglight uses rules to apply business logic to data collected from your environment. When pre-defined conditions 
are met, an alarm will be triggered. Using alarm templates, you can determine which alarms to apply to which 
targets, and configure threshold values as needed.

Figure 1. Sample Active Directory alarm

Domains
Foglight domains are components grouped together by a common technology. This can be a database type (such 
as DB2) or a general category (such as Infrastructure). Each domain has a default set of rules appropriate for the 
underlying technologies of that domain. For more information, refer to Monitoring Your Domains.

Targets
Targets are infrastructure objects assigned to a template for monitoring. Targets can be assigned to only one 
template. Targets not assigned to a template are monitored by the default alarm rules in the factory template.

Default Templates
Foglight includes a factory template, which is used as the default template unless a different default is configured. 
You are able to select a default template for each domain, which will be applied to objects in that domain without 
the need to add them as targets to the template.
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Using the Alarm Templates Dashboard
Access the Alarm Templates dashboard from the navigation panel: Alarm Templates

Figure 2. The Alarms Templates Dashboard

The Alarm Templates dashboard displays the default factory template and any duplicated or created templates. 
For each template, you can view the configured targets, selected domains, and available alarms for that domain. 
The Alarm Templates dashboard contains the following elements:

• Templates menu: displays the factory template and any templates created or duplicated. Also contains the
elements below.

▪ Template Search: Allows you to find templates with names containing the entered search string.

▪ Create Template: Use this option to create a fresh template rather than duplicating an existing
template.

▪ Set Defaults: Allows you to set the default template for each domain.

• Domains tabs: Foglight groups monitored components into domains based on common technology. Each
domain requires a different set of alarms and rules. Click the tab to view the alarms and values for the
selected domain.

The domains tab also includes a drop-down menu from which you can select a domain.

• Alarms table: the alarms table displays information about the alarms in the selected domain, as well as the
status of the alarm (on or off) and the threshold values for triggering the alarm.

• Alarm Search: Allows you to find alarms with names containing the entered search string.

• Targets table: displays targets to which the selected template is applied. Targets are domain specific.

Understanding the factory template
Foglight provides a factory template which includes the available alarms for each domain. Each alarm is enabled 
or disabled based on the default cartridge configuration and uses (where appropriate) the threshold values 
described in the alarm. 
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Figure 3. The factory template

Template Behavior
The default configuration of the factory template is determined by global registry variables configured in the Rules 
Administration dashboard.  If these values are modified for an alarm, they will be applied to the factory template as 
well as any template in which the alarm has not been changed. If an alarm is modified in a new or duplicated 
template, then any changes made in the Rules Administration dashboard to that alarm will be ignored for that 
template.

If future Foglight versions include changes to the default rules, these changes will be automatically incorporated 
into the factory template when upgrading the Foglight Management Server or any cartridges. Any template in 
which the updated alarms have not been modified will also update the default alarm rules.

Duplicating the factory template
You must duplicate the factory template before modifying any alarm settings. Foglight provides two methods for 
duplicating the factory template.

• When viewing the template, click the checkbox or On/Off toggle. A notice will be displayed informing you
that you cannot edit the factory template. Click Duplicate.

• Follow the procedures described in Duplicating a template.

NOTE: The factory template cannot be edited.  To modify the default settings, duplicate the factory template 
and make the required changes in the duplicate template.
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Working with templates
Foglight supports the following operations against templates:

• Creating a new template

• Duplicating a template

• Viewing template information

• Attaching Targets to Templates

• Removing Targets from a template

• Viewing template information

• Deleting a template

Creating a new template
Foglight supports two methods for creating new templates: creating a new template from scratch and duplicating 
an existing template (see Duplicating a template).

The primary difference between the two methods is that duplicating an existing template copies any custom 
configurations in that template, while creating a new template uses the domain defaults.

When creating a new template, the default alarm configuration for the selected domains will be populated. Any 
changes to the default configuration will be applied to targets of this template. Future changes to the default 
alarms will not be applied to the new template.

To create a new template:

1 In the templates panel, click  to open the Create Alarm Template dialog.

2 Enter a template name and description

3 In the Domains drop-down, select the domains to apply to the template.

4 Click Create. The new template will be displayed.

5 Make any desired changes to the template. Refer to Viewing template information and Attaching Targets to 
Templates. 

Duplicating a template
To duplicate a template:

1 In the templates panel, hover over the template to be duplicated. The more actions icon will appear. Click 

 to view the available actions.

2 Click Duplicate.

3 Complete the Duplicate Alarm Template dialog, using the below information as a guide:
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▪ Give the new template a unique name and accurate description.

▪ Click the Domains drop-down to select the domains to which the new template should apply.

When duplicating a template, the list of available domains is restricted to those included in the
original template. If you are duplicating the factory template, you can choose from the full list of
domains. If you are duplicating a different template, then only the domains included in that template
will be available.

4 Click Create.

5 [Optional] Set the new template as the default template. Refer to Setting Default Templates. 

Setting Default Templates
Any alarm template can be set as the default template for the domains associated with that template. Domains can 
have only with one default template. Any object in that domain that is not associated with another alarm template 
will have the default template applied.

To set a template as default:
1 In the templates panel, hover over the template to be used as the new default. The more actions icon will 

appear. Click  to view the available actions.

2 Click Set as Default.

3 Click OK to confirm.

Additionally, you can view the current domain default templates in one dialog, and make changes as required.

To view and set domain defaults:
1 Perform one of the options below:

▪ Set multiple domain defaults from the template panel:

a In the templates panel, click  to open the Set Defaults dialog.

b [Optional] Toggle Don't Show empty domains to either view all domains, or only those 
with targets.

NOTE: The duplicated template will not contain any targets. To apply the template to targets, see <targets>.
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c View the default template for each domain. Use the drop-down to assign a new default 
template.

d Click Set Defaults when finished.

▪ Set one or more domain defaults from the template:

a In the templates panel, click a template to view it.

The domains menu list each domain to which the template applies. 

b Next to the desired domain, click the down-arrow and click Set as Default.

c Click OK.

Viewing template information
Use the Info option to view a summary card containing key data points about a template. The information card 
displays:

• The template name and descrition

• The time and date the template was last modified

• The number of assigned targets

• The number of enabled rules.

To view template information:

1 In the templates panel, hover over the chosen template. The more actions icon will appear. Click  to 
view the available actions.

2 Click Info.

The template information card will be displayed.
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Editing templates
Alarm templates consist of a set of domain-specific rules that trigger alarms when the configured conditions are 
met. When editing alarm templates, you can either edit the template details (name, description, applied domains) 
or edit the alarms and alarm parameters. 

To edit alarm template details:
1 In the templates panel, hover over the template to be used as the new default. The more actions icon will 

appear. Click  to view the available actions.

2 Click Edit.

3 Make changes in the Alarm Template Name and Description field as required.

4 To change domains to which the template should apply, click the Domains dropdown. Select or clear 
domains as required.

5 Click Save.

To edit alarms and alarm parameters:
1 In the template panel, click on the template you wish to edit. The template will be displayed, with the alarms 

grouped by domain.

2 Click the tab for the domain you wish to edit.

3 Edit the alarms as needed, using the information below as a guide:

To enable or disable an alarm:

a Using the search function if necessary, find the alarm in the alarm table. 

b Toggle the On/Off setting. 

OR

a To enable disable multiple alarms, select the alarms using the checkbox. Use the search function if 
necessary. 

You may combine results from multiple searches. 

b A banner will display the number of selected alarms, and offer the options

▫ Enable All

▫ Disable All

▫ Unselect All

Click the desired option.

To edit threshold values:

a Using the search function if necessary, find the alarm you wish to edit in the alarm table. 

b Hover over the alarm to view the edit icon . Click the icon.

c The threshold options displayed vary based on the domain and alarm. An example is shown below.
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d For each threshold, you can toggle that value on or off, or change the value that will trigger the 
alarm.

e Click Apply to save changes, or the X to cancel.

Attaching Targets to Templates
Alarm template targets are infrastructure objects monitored by Foglight. By default, every target is monitored by 
the factory template. To change the alarm rules monitoring a target or set of targets, you can attach those targets 
to a different alarm template.

To attach a target to a template:
1 In the template panel, click on the template you wish to add targets to. The template will be displayed, with 

the alarms grouped by domain.

2 Click the desired domain. Click Targets.

3 Click Add Target. A list of available targets for that domain will be displayed.

4 For larger environments, the list of available targets will be quite large. Use the options below to find your 
desired targets more easily:

▪ Filter by type - Some domains offer the ability to filter targets by type. While the specific target
types available differ by domain, the method to select a target type is the same. To filter by target
type, click the Type drop-down and select the desired target type. Only targets of that type will be
displayed.

▪ Search - You may use the search function to filter targets to show only targets matching the search
string. When searching for targets, Foglight will display matches for the search term in any field
(Target, Current alarm template, Type, and Host).

5 Select the desired targets. Click Add Selected Target(s).

For database targets, adding a target to a template will also assign that template to the selected agent in 
Databases > Alarms> Alarm Template Settings.

Removing Targets from a template
Targets can only be attached to one template. To delete a template or assign a target to a new template, you must 
first remove it from its current template. 

Once a target is removed from a template, it will be monitored according to the rules of the domain default 
template. If the removed target has a parent object, and that parent object is assigned to a template, then the 
removed target will be monitored according to the parent object’s template.
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To remove a target from a template:
1 In the template panel, click on the template you wish to add targets to. The template will be displayed, with 

the alarms grouped by domain.

2 Click the desired domain. Click Targets.

3 Select the target(s) to be removed. 

4 Click Remove All to remove all selected targets, or click the trash can icon to remove one target at a time.

Deleting a template
Before deleting a template, make sure that all assigned targets have been removed. See Removing Targets from a 
template.

To delete a template:

1 In the templates panel, hover over the template to be deleted The more actions icon will appear. Click 
to view the available actions.

2 Click Delete.

3 A confirmation dialog is displayed.Click Delete.

If targets are assigned to the template, an error will be displayed. If no targets are assigned, the template 
will be deleted.
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Monitoring Your Domains

In Foglight, domains are monitored components grouped together by a common technology. For example, 
operating systems are grouped together in the Infrastructure domain and application servers are part of the 
Custom Applications domain. Domains represent parts of your environment that you are interested in monitoring.

Each technology type is considered a subdomain. For example, each type of operating system in the Infrastructure 
domain is a subdomain.

Use the Domains dashboard to monitor your environment if you are a domain Administrator or simply prefer to 
think of your environment in terms of domain groups. This dashboard allows you to obtain a high-level view of the 
state of your monitored domains and investigate problems in a particular domain. It also shows you what domains 
you are not monitoring, but could be.

Access the Domains dashboard from the Welcome page by clicking Homes > Welcome > View Your Enterprise 
Health > View Enterprise Health Organized by Monitoring Domain.

Figure 1. The Domains dashboard.

Viewing detailed information for a 
domain or subdomain
Drill down on a domain name to view a high-level summary of its monitored components. For example, click 
Infrastructure to view all monitored virtual and physical hosts in the Hosts dashboard.

By default, the Domains dashboard shows only top-level domains. Expand a domain node to view its subdomains.

Each monitored subdomain comprises the actual instances of that technology type in your environment. Click a 
subdomain name to drill down to details about it. For example, click Linux to navigate to the list of Linux hosts or 
click Oracle to drill down to the Oracle Global View.

TIP: You can also access the Domains dashboard from the navigation panel: select Homes > Domains.
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Investigating Problems in a Domain
Use the Domains dashboard to monitor for problems in your domains — for example, to see if a domain is in a 
Critical state, or if any alarms have been fired for its components — and take action on them.

Investigating a Domain or Subdomain’s State
By default, a domain or subdomain reflects the current worst state (normal, warning, critical, or fatal) of its 
components.

Click the State icon to investigate the state of a domain or subdomain that is displaying a warning, critical, or fatal 
icon.

A popup appears that lists the domain or subdomain’s alarm sources (for example, hosts, application servers, or 
databases) and their health. These are the components that contributed to the domain or subdomain’s state.

Depending on the problem you are investigating, do one of the following to drill down to more detailed views:

• Click an alarm source to drill down and see more details about it.

• Drill down to views that display the health of all alarm sources.

• Drill down to view the health of the current object (for example, Infrastructure domain or the Linux
subdomain).

• Drill down to view all outstanding alarms for the domain or subdomain.

Investigating a Subdomain’s Health
Foglight displays each monitored subdomain’s recent health in the History column. This column summarizes the 
subdomain’s health for the dashboard’s time range.

The colored segments in the column represent the subdomain’s alarm severity state at different intervals within the 
time range. Yellow segments represent warning alarms, orange segments represent critical alarms, and red 
segments represent fatal alarms. Green segments represent intervals without alarms.

To investigate the health history:
1 Hover the cursor over a segment in the health history bar to display a popup with a list of related alarms 

that occurred during that interval.

2 Click the health history bar.

A more detailed Health History view appears.

3 Click and drag the timeline to zoom in on an interval in the bar.

The chart zooms in on the selected time range.

4 Click a red, orange, or yellow segment in the detailed health history bar to find alarms that are causing the 
host to be in a non-normal state during that interval.

A popup with details about the alarms that fired during that interval appears. See Viewing, Acknowledging, 
and Clearing Alarms on page 49 for more information about working with alarms.

TIP: After zooming in, hover the cursor over the bar to cause the zoom menu to appear. To restore 
the previous time range used by the bar, click the Previous Zoom icon ( ). To restore the bar’s 

timeline to its initial state, click the Restore Zoom icon ( ). To freeze the dashboard’s time range at 
the same interval spanned by the bar’s zoomed-in range, click the Update page with zoomed time 
range icon ( ).
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Investigating a Subdomain’s Alarms
The counts in the Alarms column represent the total number of alarms fired for the components in a subdomain; 
for example, for all monitored virtual hosts in the Infrastructure > VMWare subdomain.

Use this column to view the number and type of alarms fired for these components during the dashboard’s current 
time range.

Click an alarm to display a popup that contains the standard alarm list. See Viewing, Acknowledging, and Clearing 
Alarms for more information about working with alarms.

Investigating Problems with a Subdomain’s 
Agents
You can view the state of the agents related to a subdomain in the Agents column.

Click a warning, critical, or fatal state icon to display a list of agents with health problems or drill down to the Agents 
dashboard. For more information, see the online help for the Agents dashboard.
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Monitoring Your Services

In Foglight, a service is any component or group of components that you want to monitor. If you have the 
Advanced Operator role, you create services in the Service Builder dashboard that reflects the components in your 
monitored environment that are meaningful or interesting to your organization. 

Examples of services include:

• An application, including its Web servers, application servers, and databases.

• A collection of related systems, such as all Windows machines in your monitored environment.

• A business process, such as retail banking.

Each service can include any component in your monitored environment, including other services. A service 
inherently has a service level and relationships of impact and dependency to other services. 

For information about how to create a service, see the topic “Creating a Service” in the online help.

The My Services dashboard is the best way to monitor a selected set of services. Use it to tailor the way Foglight 
presents information about monitored components so that it suits your specific needs. 

Access the My Services dashboard from the Welcome page (Welcome > View Your Enterprise Health >View 
the Health of Critical Services).

Figure 1. My Services dashboard

TIP: You can also access this dashboard from the navigation panel: select Dashboards > Services > My 
Services. Visit http://eDocs.quest.com to watch our learning video. See Working with the My Services 
Dashboard. 

http://eDocs.quest.com
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Follow the instructions in this chapter to monitor a specific group of services that interests you by:

• Selecting these services.

• Displaying service breakdowns based on the Alarms state and SLA state.

• Viewing details about your services, such as their state, contents, and dependencies.

Selecting the Services You Want to 
Monitor
By default, no services are listed in the My Services dashboard. This is by design: it gives you the opportunity to 
customize the My Services dashboard to suit your needs. Select the set of services that you want to monitor so 
that they appear in this dashboard.

To select services:
1 Open the My Services dashboard and click Manage Services Watch List.

The Select services to watch list dialog box appears.

2 In the Name tab, explicitly select each service you want to monitor (selecting a service does not 
automatically select its children). 

3 Click Apply.

Monitoring a Service
Once you subscribe to a service, you can drill down and view details about that service.

These sections describes workflows for monitoring the overall health of your critical services and investigating 
problems with them.

• Drilling down into a service

• Viewing Services Details page

Drilling down into a service
When you drill down into a service by clicking  for a particular service. The view that appears depends on 
whether or not your Administrator configured a custom view using the Service Builder. If your Administrator did not 
configure a custom drill-down, you see a Service Summary dialog box listing the outstanding alarms and links to a 
default service breakdown. In addition, it provides a link to edit the service using the Service Builder dashboard. If 
your Administrator chose a custom view, it appears in the drill-down dialog box.

TIP: Use the search features to find services you are interested in. The search is per keyword, 
delimited by spaces. For example, if you want to search on “Global Service” (instead of “Global”), add 
quotes around “Global Service” to match that exact string.

NOTE: To use the following functions, Foglight users require the Advanced Operator role.
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Viewing Services Details page
View more details about your services by clicking  at the bottom right corner of the service and a Service 
Details page for certain service will be open.

Investigating Service Levels tab
You monitor services because you have a specific business requirement to ensure the availability of these 
components. The icons in the Service Level Compliance column reflect the availability of your services. Use this 
column as a starting point for investigating how problems with your services affect their service levels.

Foglight automatically examines each service and establishes its availability and service level compliance. By 
default, a service is available if it does not have any fatal alarms.

In Foglight, a service’s state is based on the worst state of the components it includes. For example, a 
MyApplication service contains services for its Web servers, application servers, and databases. The databases 
service is in a fatal state because it has a fatal alarm and the other two are in a warning state. MyApplication is 
also in a fatal state and is listed as non-compliant with its Service Level Agreement (SLA).

To investigate a service’s availability and service level compliance:
1 In the row for the service, click the Fatal icon in the Service Level Compliance column. This icon indicates 

that your service is not compliant with its SLA.

A Service Level Compliance Summary popup appears for that service.

2 Use this dialog box to view the service level agreements, compliance, current and recent availability, and 
any service level alarms that have been fired for that service.

3 If there is anything in the dialog box that you want to investigate further, drill down on that aspect of service 
level compliance.

Table 1. View Services Details page

Select the Tab... To show...
Service Level A summary of the service level compliance, alarms, and availability. For more 

information, see Investigating Service Levels tab on page 69.
Dependencies Two types of service dependencies are displayed:

• Application Infrastructure
Shows the related hosts and service's components, grouped by child services.
The relationship is collected by FMS.

• Services
The list of services on which the selected service depends. That is, the list of
services added to the selected service.

This diagram shows the composition of your service and the state of each component it 
contains. Use it to quickly scan for the root cause of a problem reported on the service. 
For details, see Visualizing the dependencies among services on page 70.

Heatmap Heatmap visualizes components by alarms. 
In the Heatmap, the size of the block is determined by the numbers of current alarms 
related to the component, and the color is determined by the highest severity level of the 
alarms related to the component.

Current Alarms A list of uncleared alarms fired for components included in the selected service. See 
Viewing, Acknowledging, and Clearing Alarms on page 49 for information about working 
with alarms.

History Alarms A list of alarms fired for components included in the selected service. The alarm count 
includes all filtered alarms fired on hosts that are part of the service. See Viewing, 
Acknowledging, and Clearing Alarms on page 49 for information about working with 
alarms.
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For example, the Availability History sparkline displays dips that concern you. You want to investigate your 
service’s availability for a specific interval you are concerned about, so you click My Services > Explore on 
specific service > Service Levels tab to navigate to the Service Levels dashboard. You then zoom in on 
one of the availability graphs in this dashboard. See the online help for the Service Levels dashboard for 
more information about it.

Visualizing the dependencies among services
Click the Dependencies tab to display a graphic representation of the hierarchy of services that the selected 
service comprises. Use the components state icons to trace the critical path of performance issues across a 
domain.

Use the depth control, in the upper right corner, to set the number of levels (1-3) in the diagram. The default setting 
is two levels.

The dots above the depth control determine the scale of the diagram.

• Click the smaller dot to reduce the scale for easier navigation of large diagrams.

• Click the medium dot to restore the diagram to its original scale.

• Click the largest dot to zoom to the highest zoom level.

By default, Foglight arranges the components in a tree diagram. You can also manually change the components’ 
layout to position them as you wish. When you move a component, Foglight clears the Auto Arrange check box. 
Select the Auto Arrange check box to return to the original layout.

Investigating alarms
Investigate a service’s alarms to get more details about the problems contributing to its non-normal state.

To investigate alarms related to a service:
• Click the icon that represents the service’s warning, critical, or fatal alarms.

An alarm list appears showing only those alarms. See Viewing, Acknowledging, and Clearing Alarms on
page 49 for information about working with alarms.

TIP: Both current availability and SLA measurements are; use them in different situations:

• Use the current availability measurement to find and address immediate problems quickly.

• Use SLA measurements to determine if you are meeting overall service level expectations.
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Monitoring Your Hosts

This chapter describes how to monitor hosts using workflows that start in the Hosts dashboard. By following these 
workflows, you can view the performance of all monitored hosts or drill down on a single host. 

Access the Hosts dashboard from the Welcome page (Homes > Welcome > View Your Enterprise Health > 
View the Health of the Monitored Hosts in Your Enterprise).

Figure 1. View the performance of all monitored hosts.

Use the Hosts dashboard to monitor for problems in your environment if you are responsible for the availability of a 
set of hosts and prefer to think in terms of systems. The Hosts dashboard provides the best high-level summary of 
host state and performance, including alarms, CPU, memory, disk, network utilization, if a host is being monitored, 
and impacted services.

Drill down from this dashboard to different dashboards and views that provide more detail about your hosts. You 
can also use this dashboard to see if a host’s state has an impact on services and view the health history of each 
host.

Selecting a set of hosts to monitor
The Hosts dashboard is useful for monitoring environments with a large number of hosts, since you can choose to 
show only a subset of these hosts or display all hosts.

In many cases, you need to focus on a subset of these hosts. There are different ways to do this in the Hosts 
dashboard:

• Use the field at the top of the table to filter the list of hosts by name—for example, to display only the hosts
with “database” in their names.

TIP: You can also access this dashboard from the navigation panel: select Homes > Hosts.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See How to Use the Folflght Hosts 
Dashboard. 

http://eDocs.quest.com
http://eDocs.quest.com
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• Use the menu under the Filter By Activity area to show only hosts in a specific category—for example, all
Windows hosts.

If you need to see data for all hosts in your environment, you can:

• Work with the default settings in the Filter By Activity area and the menu underneath it (Monitored Hosts
Only and All Hosts, respectively).

All hosts for which Foglight collects CPU and memory metrics are listed in the table.

• Select All Hosts from the Filter By Activity area and leave the default setting All Hosts in the menu
underneath this area.

All hosts in your monitored environment are listed in the table.

Identifying the types of hosts you are 
monitoring
The icons in the Type column allow you to see at a glance what kind of hosts you are monitoring: physical hosts 
are identified by the icon , VMware images by the icon , and ESX servers by the icon . Each icon displays 

the state embedded on top. For example, a physical host in a normal state has the following icon .

Monitoring the state of hosts
Now that you have chosen the group of hosts you want to monitor, refer to the icons in the first column in the table 
to see the state of these hosts at a glance. Each state indicator shows the host’s aggregate alarm state (excluding 
the state of agents on that host).

Investigating Alarms for a Host
Investigate a host’s alarms to get more details about the problems contributing to its non-normal state. In the row 
for the host, click the icon that represents warning, critical, or fatal alarms to display an alarm list filtered to show 
only the warning, critical, or fatal alarms for that host. See Viewing, Acknowledging, and Clearing Alarms on page 
49 for information about working with alarms.

Viewing the host performance
The CPU, Memory, Disk, and Network columns allow you to obtain a concise overview of your hosts’ performance 
in these metric categories. The values in these columns—and the popups and drilldowns available from them—
change with the dashboard's time range.

NOTE: If a Host is not currently being monitored, contact your Administrator to configure the host. For 
more information, see the Administration and Configuration Guide.

TIP: If you have the Advanced Operator role, you can save the results of your search as a filter using 
the groups toolbar above the table. Type the search criteria in the field in this toolbar, click Search to 
filter the list of hosts by name, and then click the plus-sign button ( ). The Create Simple Global 
Service dialog box appears. Type a name for the filter and a description and then click Create. The 
Create Simple Global Service dialog box appears. Type a name for the filter and a description and then 
click Create. The filter is listed in the menu, along with the default filters.
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These columns display recent and current values for each metric category. Recent values are displayed as a 
sparkline in the Utilization column.

To investigate a host’s CPU-, memory-, disk-, and network-related performance:
1 Hover the cursor over the sparkline or current value in the CPU, Memory, Disk, and Network column for 

that host.

A popup appears. It contains a utilization chart for that metric.

2 To investigate further, click the sparkline or current value.

A dashboard appears that contains details for that metric category.

Figure 2. The CPU Details dashboard.

TIP: By default, a sparkline is shown only in the CPU Utilization column. To display sparklines for other 
metric categories, click the Show columns icon ( ) at the top of the table and select the Utilization 
checkbox under Memory, Disk, or Network.

TIP: Hover over a line or area in a chart to display data for the nearest time in a tooltip.

Table 1. Click a column for a detailed dashboard.

If you click this 
column... This dashboard appears...

CPU CPU Details (example shown below): use it to identify the top CPU consumers on the 
host, see the top processes’ utilization trends, and view charts for CPU utilization 
process load.

Memory Memory Details: use it to investigate overall memory utilization on the host and the 
amount of memory the top processes are consuming. The Top Memory Consumers 
table lists both resident and virtual sizes for the top processes.

Disk Disk Details: use it to identify the top disk I/O consumers on the host, see the 
utilization trends of the top CPU processes, and view charts for disk size and bytes 
read and written.

Network Network Details: use it to investigate the aggregate network utilization of the host and 
view the activity of your network connections.



Foglight 7.1.0 User Guide 
Monitoring Your Hosts 74

Viewing dependencies for a host
You can view the dependencies for a selected host you are monitoring in the Host Monitor dashboard by clicking 
Host Dependencies on the General tab of the action panel. If you have the Cartridge for Dependency Mapping 
installed, this feature allows you to view the elements in the host’s dependency chain. For more information, see 
the Managing Dependency Mapping User Guide.

Determine if the state of a host impacts 
your services
If one of your hosts is in a state other than Normal ( ), use the impacted services popup to view which of your 
services that host might impact. This popup helps you establish whether critical services are affected by problems 
with your hosts and decide if immediate action is necessary to resolve these problems.

To view a host’s impacted services:

• Click the icon ( ) in the Impacted Services column for the host you are investigating.

The impacted services popup shows a summary that lists the name of the impacted service, its aggregate
state, and its aggregate state history.

NOTE: You can only view user-defined impacted services. System services are not shown.

NOTE: The Service Health History column is hidden by default. To view it, click the Show 
columns icon ( ) and then select the column in the popup.

TIP: In addition to the dashboards described in this chapter, Foglight provides you with other views on 
your hosts. For details, see the online help for the dashboards listed under Dashboards > Hosts in the 
navigation panel.
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Reporting on Your Enterprise

Reports are a convenient way to share data about your monitored environment with others in your organization. 
The Reports dashboard is your starting point for working with reports. Use it to create and schedule reports and to 
access the Manage Reports dashboard. You can create:

• Pre-defined reports. Use out-of-the-box templates to obtain a quick, high-level perspective on your data.
See Running a Report on page 75.

• Custom reports. Create custom report templates to tailor the content and presentation of your reports to
suit your needs. See Building a Custom Report on page 76.

The Report Manager role allows users to schedule as well as generate the reports for which they have role 
access. It is different from the Operator role, for example, in that users granted the Operator role can generate 
reports but cannot schedule them. With the Report Manager role, users cannot create new report templates 
through the Definitions editor or create reports using the drag and drop feature initiated from the action panel. The 
Advanced Operator role grants users access to all report functionality. Access the Reports dashboard from the 
Welcome page (Homes > Welcome) by clicking Report on Your Enterprise.

Figure 1. The Reports dashboard.

The Reports dashboard also provides at-a-glance reporting details. It displays the number of report templates 
available to you, the number of scheduled reports, and information about upcoming scheduled reports and 
recently generated reports.

A Reports menu is located at the top-right corner of each dashboard. From this menu, you can quickly create a 
new report, run a report, and manage reports. You can access the same menu from the General tab on the action 
panel by expanding Other Actions and clicking Reports.

Running a Report
Foglight contains a number of pre-defined report templates. Each template serves a particular purpose, but many 
templates have the same expected inputs. The values you specify for these inputs define the content of the report.

NOTE: You can also access this dashboard from the navigation panel: select Homes > Reports.
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Use a template as-is to quickly generate or schedule a report, or change the report input values to meet specific 
requirements.

Running a Report
Click Run a Report on the Reports dashboard to select and generate a report immediately (in the PDF format, for 
example) using the Create Report wizard. If you have the Manager Report role or the Advanced Operator’s role, 
you can also schedule a report from this wizard. See the online help for the Reports dashboard for details about 
using this wizard.

Building a Custom Report
You can also create a custom report template, which is similar to creating a dashboard. By creating your own 
report templates, you can build reports directly from any dashboard or tailor the content and presentation of 
reports to suit your requirements.

Creating a Custom Report Template
Click Build a Custom Report on the Reports dashboard to choose the building blocks for your custom report 
using the Create Report wizard. See the online help for the Create Report wizard, for details about using this 
wizard.

Immediately after building a custom template, you can use it to generate a report

Generating a Custom Report
The custom report templates you create appear under My Dashboards in the navigation panel. To run a report 

immediately based on one of these templates, select the template and click Run ( ) on the toolbar. 

Each time you run a report based on a custom report template, you can change the data Foglight includes in the 
report by setting the parameterized input values. For more information, see the online help topic,.

Deleting a Custom Report Template
Delete custom report template by selecting the template under My Dashboards and clicking Delete this Report 
form General > Actions in the action panel. Foglight removes the report from My Dashboards and the report 
template list.

TIP: To create a report based on the monitoring dashboard you are viewing, select Reports > Create a 
New Report from the reports menu at the top-right corner of the dashboard, and then select Create a 
report based on the current dashboard.

NOTE: Users with the Administrators role can remove unwanted scheduled reports created by other 
users. Users with this role also have access to all of the available report templates. A user who does 
not have the Administrator role can only see report templates that have the role that matches their user 
role.
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Managing Reports
Click Manage Reports on the Reports dashboard to access the Manage Reports dashboard.

Figure 2. The Manage Reports dashboard.

Use this dashboard to filter, download, delete, and view details about scheduled and generated reports. If you 
have the Advanced Operator role, you can also use this dashboard to:

• Delete scheduled reports. For example, you no longer require a specific scheduled report because you
removed the service on which it reports.

• Enable/disable scheduled reports. For example, you are performing system maintenance and you do not
want Foglight to run scheduled reports during that time.

• Edit scheduled reports. For example, you want to change the maximum number of hosts included in a
scheduled report.

• Select a template and run a report.

• Filter the reports list that is displayed in the view.

You can also use the Manage Reports dashboard to generate and schedule reports from the context of your 
existing set of reports. For example, you view a one-time report and decide that it should be generated 
automatically at the end of each month. 

If the out-of-box schedules available in the Schedule Report wizard do not meet your requirements, your 
Administrator can define a new schedule using the Simple New Schedule wizard. This is the same wizard that 
Administrators use to create new blackout schedules. Ask your Administrator for assistance if you need a new 
schedule.

Video Tutorials
There are a number of Foglight learning videos available. To view a video, on the action panel, select the Help tab, 
expand Using Foglight > Foglight User Help > Reporting on Your Enterprise > Video Tutorials, and then click 
the title of the video you wish to view.
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Figure 3. The Foglight help menu, displaying the video tutorials.
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About Us

Quest creates software solutions that make the benefits of new technology real in an increasingly complex IT 
landscape. From database and systems management, to Active Directory and Office 365 management, and cyber 
security resilience, Quest helps customers solve their next IT challenge now. Around the globe, more than 130,000 
companies and 95% of the Fortune 500 count on Quest to deliver proactive management and monitoring for the 
next enterprise initiative, find the next solution for complex Microsoft challenges and stay ahead of the next threat. 
Quest Software. Where next meets now. For more information, visit https://www.quest.com/.

Technical support resources
Technical support is available to Quest customers with a valid maintenance contract and customers who have trial 
versions. You can access the Quest Support Portal at https://support.quest.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 
day, 365 days a year. The Support Portal enables you to:

• Submit and manage a Service Request.

• View Knowledge Base articles.

• Sign up for product notifications.

• Download software and technical documentation.

• View how-to-videos.

• Engage in community discussions.

• Chat with support engineers online.

• View services to assist you with your product.

https://www.quest.com/
https://support.quest.com
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